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Matrox Software License Agreement

(HEREAFTER REFERRED TO AS LICENSE)

THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD
(“MATROX”) CONCERNING THE USAGE OF THE MATROX SOFTWARE. BY DOWNLOADING,
INSTALLING, COPYING, ACCESSING, CLICKING ON AN “ACCEPT” BUTTON, OR OTHERWISE USING
THE SOFTWARE, THE LICENSEE AGREES TO THE TERMS OF THIS LICENSE. IF YOU ARE ACCEPTING
THESE TERMS ON BEHALF OF YOUR COMPANY, ORGANIZATION, EDUCATIONAL INSTITUTION, OR
AGENCY, INSTRUMENTALITY, OR DEPARTMENT OF THE FEDERAL GOVERNMENT AS ITS
AUTHORIZED LEGAL REPRESENTATIVE, YOU REPRESENT AND WARRANT THAT YOU HAVE FULL
AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
LICENSE, PLEASE RETURN YOUR MATROX PRODUCT. IF THE SOFTWARE WAS DOWNLOADED,
DESTROY ALL COPIES OF THE SOFTWARE.

In this License “Software” refers to: any firmware, software, associated software components, media, printed
materials, and “online” or electronic documentation related to Matrox products.

The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This License
does not cover the sale of hardware, since it may not necessarily be sold as a package with the Software. This License
sets forth the terms and conditions of the Software license only.

Any Software provided to Licensee is the copyrighted work of Matrox and/or third party software suppliers (if any).
The present License does not give Licensee any intellectual property rights to the Software or its derivatives. The
downloading and/or the use of any Software are subject to the following restrictions and limitations:

LICENSES:

If you are an end user, the “End User License” shall apply to you.

If you are an original equipment manufacturer (OEM), the “OEM License” shall apply to you.

END USER LICENSE
1 Licensee may install the Software on an unlimited number of computers owned or leased by Licensee in any
location. The Software is subject to a restricted license therefore Licensee must use the Software on a single
computer owned or leased by Licensee at a time, in conjunction with and for the purpose of, operating the Matrox
hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not licensed
hereunder. Licensee shall also have the right to make one copy of the Software in any computer-readable or printed
form for back-up or archival purposes;

N

No right to recopy, publish, display, network, rent, loan, lend, assign, sell, distribute, license, sub-license, alter,
modify, disassemble, de-compile, create derivative works or reverse engineer any Software in any manner
whatsoever is hereby given, except as provided in this License. Violation may result in severe civil and/or criminal
penalties, as violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using the
same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such, or to
use this Software to: (i) develop inventions directly derived from confidential information to seek patent
protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify Licensee's
existing patents or patent applications;

4 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the
purpose of installation, service integration and/or support of said Software within Licensee's product. In such
event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to
accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this License;

5 Licensee may not grant any sublicense, lease or other right in the Software to others;
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6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback™),
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or
other consideration to Licensee;

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent
notices in the Software.

OEM LICENSE
Licensee may reproduce and distribute the Software only as an integral part of or incorporated in Licensee's
product or as a standalone Software maintenance update for existing end users of Licensee's products, excluding
any other standalone products, subject to these conditions:
1 This Software is subject to a restrictive license therefore it is licensed for use only in conjunction with the
Matrox hardware product. Use of the Software in conjunction with non-Matrox products is prohibited and not
licensed hereunder;

N

No right to recopy, publish, display, sell, network, rent, loan, lend, distribute, license, sub-license, alter,
modify, disassemble, de-compile, create derivative works or reverse engineer any Software in any manner
whatsoever is hereby given, except as provided in this License. Violation may result in severe civil and/or
criminal penalties, as violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using
the same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such,
or to use this Software to: (i) develop inventions directly derived from confidential information to seek
patent protection; (ii) assist in the analysis of Licensee's patents and patent applications; or (iii) modify
Licensee's existing patents or patent applications;

4 Licensee may only distribute the Software to Licensee's customers pursuant to a written license agreement.
At a minimum such license shall safeguard Matrox's ownership rights to the Software and such agreement
shall contain similar terms and obligations;

5 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for
the purpose of installation, service integration and/or support of said Software within Licensee's product. In
such event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third
party to accomplish his work provided that all such disclosures shall be subject to the terms and conditions
of this License;

6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback”),
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or
other consideration to Licensee.

7 Licensee shall not have the right to alter or remove any Matrox or third party copyright, trademark or patent
notices in the Software.

GENERAL LICENSE TERMS: (APPLICABLE TO BOTH END-USERS & OEM'S)

There are inherent dangers in the use of any software available for downloading on the Internet and Matrox
cautions Licensee to ensure that Licensee completely understands the potential risks before downloading any of
the Software. Licensee is solely responsible for adequate protection and backup of the data and equipment used
in connection with any of the Software, and Matrox will not be liable for any damages that may be suffered in
connection with use of the Software.

Licensee hereby acknowledges and agrees that this License, and all its terms and conditions, automatically
applies, without other notice, to future updates of the Software, firmware, BIOS, drivers and associated utilities.

In addition, certain third party intellectual property may be provided with or included in the Software. The third
party license terms accompanying such Software, found at http://www.matrox.com/video/licenses and if
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iii
applicable, in the license.txt file located in the root installation directory, will govern your use of such Software.
Matrox does not warrant and is not liable for such third party intellectual property, or anything related thereto.
Licensee acknowledges and agrees to comply with the terms of all applicable third party software licenses if any.
Please be advised that the terms and conditions of third party license agreements may be updated from time to time. It
is the Licensee responsibility to verify that the agreement listed is current and applicable. Please note that this list of
third party licenses is not exhaustive and was determined according to Matrox's understanding and to the best of its
knowledge.

PRE-RELEASE LICENSE EXCLUSION: If you are using a version of the licensed Software that is designated,
without limitation, as an alpha, beta, engineering sample, preliminary or early access version of the Software, then; (a)
the Software is deemed to be pre-release code (e.g. alpha or beta, engineering sample, preliminary, early access, etc.),
which may not be fully functional and which Matrox may substantially modify in development of a commercial
version, and for which Matrox makes no assurances that it will ever develop or make generally available in a
commercial version, and (b) Licensee shall have the right to use the Software only for the duration of the pre-release
term or until the commercial release, if any, of the Software, whichever is shorter. For clarity, a remedy to any bug,
defect, error or fault in any pre-release version of the Software will absolutely require upgrading to a new version of
the Software. Matrox reserves the right to change any content of this new version of the Software at its sole discretion.

COPYRIGHT

All title, including but not limited to copyrights, in and to the Software and any copies thereof are owned by Matrox or
its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the
Software is the property of the respective content owner and may be protected by applicable copyright or other
intellectual property laws and treaties. This License grants you no rights to use such content. All rights not expressly
granted are reserved by Matrox.

DISCLAIMER OF WARRANTIES

LICENSEE EXPRESSLY ACKNOWLEDGES AND AGREES THAT USE OF THE SOFTWARE IS AT
LICENSEE'S SOLE RISK. THE SOFTWARE IS PROVIDED “AS IS” AND WITHOUT WARRANTY OF ANY
KIND AND MATROX EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT OF ITS SOFTWARE AND ANY THIRD PARTY
INTELLECTUAL PROPERTY. MATROX DOES NOT WARRANT THAT THE CONTENTS OF THE SOFTWARE
WILL MEET LICENSEE'S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE
ENTIRE RISK ASSOCIATED WITH THE USE OF THE SOFTWARE IS ASSUMED BY LICENSEE.
FURTHERMORE, MATROX DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE
USE OR THE RESULTS OF THE USE, OF THE SOFTWARE OR ANY THIRD PARTY INTELLECTUAL
PROPERTY IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR
OTHERWISE. SHOULD THE CONTENTS OF THE SOFTWARE PROVE DEFECTIVE, LICENSEE ASSUMES
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT
APPLY TO LICENSEE.

LICENSEE ACKNOWLEDGES AND AGREES THAT LICENSEE IS SOLELY RESPONSIBLE FOR
DETERMINING WHETHER ANY THIRD PARTY PATENT OR COPYRIGHT LICENSES, INCLUDING BUT
NOT LIMITED TO VARIOUS AUDIO AND VISUAL STANDARDS, ARE NECESSARY TO USE, IMPLEMENT
OR DISTRIBUTE THIS PRODUCT, WHICH INCLUDES ANY OR ALL SOFTWARE OR HARDWARE.
LICENSEE IS RESPONSIBLE TO ADVISE LICENSEE'S CUSTOMERS OF THE LIMITATIONS PROVIDED
HEREIN.

LIMITATION OF LIABILITY

UNDER NO CIRCUMSTANCES SHALL MATROX, ITS SISTER COMPANIES, ITS SUBSIDIARIES BE LIABLE
FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES
THAT RESULT FROM THE USE OF, OR INABILITY TO USE, THE SOFTWARE. THIS LIMITATION APPLIES
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WHETHER THE ALLEGED LIABILITY IS BASED ON CONTRACT, TORT, NEGLIGENCE, STRICT
LIABILITY, OR ANY OTHER BASIS, EVEN IF MATROX HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, MATROX'S LIABILITY IN SUCH
JURISDICTIONS SHALL BE LIMITED TO THE MINIMUM REQUIRED BY LAW.

UNAUTHORIZED USE. THIS SOFTWARE RELATED THERETO ARE NOT DESIGNED, INTENDED,
AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY TYPE OF SYSTEM
OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY HAZARDOUS
ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE
PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL
SYSTEMS, LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES,
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC
WORKS, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A
PRODUCT COULD LEAD TO PROPERTY DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL
INJURY. LICENSEE WILL NOT USE, OR PERMIT TO BE USED, THE PRODUCTS FOR SUCH
HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS AND FURTHER, LICENSEE AGREES
TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS MANAGERS, DIRECTORS,
OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, ASSIGNS AND ITS 3RD PARTY
SUPPLIERS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST, EXPENSE, DAMAGES,
AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS' FEES) ARISING
OUT OF, OR RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS RELATED HERETO, EVEN
IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING THE DESIGN OR
MANUFACTURE OF THE SOFTWARE.

DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITIES FOR THIRD PARTY SOFTWARE
INCLUDED WITH OR IN THE SOFTWARE. ALL THIRD PARTY SOFTWARE INCLUDED WITH THE
SOFTWARE IS PROVIDED ON AN “AS IS” BASIS. MATROX AND ITS 3RD PARTY SUPPLIERS MAKE
NO WARRANTY TO LICENSEE, WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE AND NON-INFRINGEMENT, REGARDING ANY THIRD PARTY SOFTWARE,
OR ITS USE AND OPERATION ALONE OR IN COMBINATION WITH LICENSEE PRODUCTS.
NEITHER LICENSEE, NOR ITS EMPLOYEES, AGENTS, OR DISTRIBUTORS HAVE ANY RIGHT TO
MAKE ANY OTHER REPRESENTATION, WARRANTY OR PROMISE WITH RESPECT TO ALL THIRD
PARTY SOFTWARE INCLUDED WITH THE SOFTWARE.

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM
AND AGAINST ANY CLAIM THAT ANY THIRD PARTY SOFTWARE INFRINGES ANY THIRD PARTY
PATENT, COPYRIGHT, TRADEMARK OR OTHER INTELLECTUAL PROPERTY RIGHT. LICENSEE
WILL PROMPTLY NOTIFY MATROX IN WRITING OF ANY SUCH CLAIM.

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD LICENSEE HARMLESS FROM
AND AGAINST ANY CLAIMS OF INFRINGEMENT OF INTELLECTUAL PROPERTY THAT READS
UPON OR IS INFRINGED BY A GENERALLY RECOGNIZED AUDIO, VIDEO, TECHNOLOGY OR
PATENT STANDARD OR RECOMMENDATIONS, INCLUDING WITHOUT LIMITATION AVC/H.264,
IEEE 1394, JPEG, JPEG2000 AND MPEG-4.

IN ANY EVENT, MATROX'S TOTAL CUMULATIVE LIABILITY TO LICENSEE FOR ANY AND ALL
CAUSE OF ACTION SHALL BE LIMITED TO THE AGGREGATE OF ALL AMOUNTS PAID BY
LICENSEE TO MATROX, DURING THE TWELVE (12) MONTH PERIOD PRIOR TO OBTAINING A
FINAL, NONAPPEALABLE JUDGMENT OR $50,000.00 USD, WHICHEVER IS LOWER. THE
FOREGOING LIMITATIONS WILL APPLY EVEN IF THE ABOVE STATED REMEDY FAILS OF ITS
ESSENTIAL PURPOSE.
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TERMINATION

This License will automatically terminate if Licensee fails to comply with any of the terms and conditions hereof. In
such event, Licensee must destroy all copies of the Software and all of its component parts. Matrox reserves the right
to terminate this License without prejudice to any additional recourses Matrox may have against Licensee if Licensee
violates any of this Licenses' terms and conditions.

Matrox will not, by reason of the termination of this License, be liable for compensation, reimbursement or damages
on account of the loss of prospective profits on anticipated sales, or on account of expenditures, investments, leases, or
commitments in connection with the Licensee's business or goodwill or otherwise. If Licensee commences or
participates in any legal proceeding against Matrox then Matrox may, in its sole discretion, suspend or terminate all
license grants and any other rights provided under this License during the pendency of such legal proceedings.

MISCELLANEOUS

If any provision of this License is inconsistent with, or cannot be fully enforced under, the law, such provision will be
construed as limited to the extent necessary to be consistent with and fully enforceable under the law. This License is
the final, complete and exclusive agreement between the parties relating to the subject matter hereof, and supersedes
all prior or contemporaneous understandings and agreements relating to such subject matter, whether oral or written.
This License may only be modified in writing signed by an authorized officer of Matrox. Licensee agrees that it will
not ship, transfer or export the Software into any country, or use the Software in any manner, prohibited by the United
States Bureau of Industry and Security and shall fully comply with all United States relevant export laws, restrictions
or regulations and any other applicable export and import laws.

Controlling Law. The validity, performance and construction hereof shall be governed by and interpreted in
accordance with the laws of the Province of Quebec. Both parties hereby irrevocably submit to the exclusive
jurisdiction of the Courts of the district of Montreal, Province of Quebec, Canada with regard to any dispute arising out
of or in connection with this License.

Additional information may be available on the Matrox website. If used, this site may contain other proprietary notices
and copyright information, the terms of which must also be observed and followed.

The failure of Matrox to enforce at any time any of the provisions of this License, or the failure to require at any time
performance by the Licensee of any of the provisions of this License, shall in no way be construed to be a present or
future waiver of such provisions, nor in any way affect the right of Matrox to enforce each and every such provision
thereafter.

Any and all articles and/or sections which by their nature are required to survive termination of this License shall
survive.

ANY INTERPRETATION OF THE CONTENTS, RIGHTS AND OBLIGATIONS OF THE CONTENTS OF THIS
NOTICE AND/OR MATROX WEB SITE SHALL BE INTERPRETED IN ACCORDANCE WITH THE LAWS OF
QUEBEC.

All rights reserved by Matrox.

Matrox reserves the right to change Software specification without notice. All intellectual property, including without
limitation, trademarks and copyrights are the property of their respective owners and any unauthorized use thereof is
strictly prohibited.

COPYRIGHT © 2015 Matrox is a trademark of Matrox Electronic Systems Ltd.
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Introduction

This chapter lists the Monarch
LCS supported input formats,
system requirements, and
describes the Monarch LCS
documentation.



Welcome to Matrox Monarch LCS

The Matrox Monarch LCS is a reliable, standalone network appliance that is
simple to set up and integrate into any open Video Management System (VMS)
or Lecture Management System (LMS). Monarch LCS lets you easily define
profiles for live streamed and recorded lectures by mixing camera and
presentation material from SDI and HDMI sources. Once configured, this
versatile H.264 encoding appliance can be operated by anyone at the push of a
button. For a full overview of the Monarch LCS, please refer to our website here:
http://www.matrox.com/video/en/products/monarch_Ilcs/#close.

Supported input formats

Matrox Monarch LCS supports the following video input formats:

* 1920 x 1080p at 25/29.97/30/50/59.94/60 fps
* 1920 x 1080i at 25/29.97 fps

» 1280 x 720p at 50/59.94/60 fps

* 720 x 576i at 25 fps (SDI only)

* 720 x 486i at 29.97 fps (SDI only)

Supported operating systems
The Matrox Monarch LCS Utils application is used to perform firmware updates
and acquire the device network IP address when connected to a network with a
DHCEP server. The application supports the following operating systems:
* Mac OS X ElI Capitan.
¢ Microsoft Windows 8.1 (64-bit).
Note Youmusthave Microsoft NET Framework installed. This release was
tested with the latest version: http://www.microsoft.com/en-ca/download/

Other operating systems may work but have not been fully validated through
internal testing. Before trying another operating system, please contact
MonarchLCSSupport@matrox.com with any questions.
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Supported Web browsers

Matrox Monarch LCS has been tested for use with the following Web browsers:
* Microsoft Internet Explorer.
» Apple Safari.

Other browsers may work but have not been fully validated through internal
testing.

Note If you experience display issues in the Command Center when using
Monarch LCS with Internet Explorer (11 or higher), disable Compatibility View
and set the Document mode to Edge:

1 From Internet Explorer, go to Tools > Compatibility View Settings, clear
Display intranet sites in Compatibility View, and then click Close.
2 Press F12 to open the developer tools interface, select Edge (default) from

the document mode drop-down menu, and then press F12 to close the tools.

The Command Center should now display properly.

Streaming

Monarch LCS provides streaming settings for using RTSP and RTMP streaming
protocols for use on media servers, video players and Content Delivery Networks
(CDN:).

Recording

Monarch LCS provides settings for recording your input source for video on
demand (VOD), high-quality editing, and archiving/previewing purposes.

About this guide

This guide provides you with information about connecting and using your
Matrox Monarch LCS device.

Style conventions
The following style conventions are used in this guide:

* The names of files, folders, and documents appear in italics. For example:
— The data is stored in the Sample.mov file.
— The file is located in the Clips folder.
— Please refer to your Matrox Monarch LCS Release Notes.

* Menus and commands that you need to choose are displayed in the form
Menu > Command. For example, File > Save means click File in the
menu bar, and then click Save in the menu that appears.

Supported Web browsers
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Matrox Monarch LCS Hardware and
Connections

This chapter describes the
Matrox Monarch LCS
connections (video/audio,
LAN, and recording), buttons,
status LEDs, and shows how
to power and reset Monarch
LCS.



Matrox Monarch LCS hardware

This section explains the Matrox Monarch LCS hardware components. For
hardware technical specifications, see Appendix C, “Matrox Monarch LCS

Specifications.”

" = o 3

Matrox*Monareh™ LSS 1

SEHECTON swicH  BvcD

- r‘ﬂ | E]‘l i, B,
HOMI— uss1— usp2—
| SDI--- ‘ il
Switch
Encode
Input select USB port 1 SD card slot
USB port 2 Reset button
PowerLED — See “Status LEDs” on page 15 Warning
LED
INB INA N
© ©
-*- = 2y € @ © 0
HOMI '—Sﬂl—' AUDIO —

VeC690C0P 090200 Pn® @ Q5952795902094 20252 9,8,8,0,9 ©,0
eBDOOOOOQOOOO OJOOOOOOOOOOOOOO JOSOGBO E)OGIOO QOOOOO 0000000000&6@1@0@

HDMI in B HDMI in A SDlin A input
Power LAN RS-232 HDMI out SDI out output P

(Analog audio)

Input select button

With the Input select button, you can select from either an HDMI or SDI input
source, and an LED illuminates indicating which source is in use. You can also
select the input source in the Command Center.

@ Important While streaming or recording, any attempt to switch between
inputs by pressing the Input select button will not have any effect, whether or
not the front panel buttons have been disabled. This is the case only for the Input
select button; however, clicking the Lock button in the Command Center

disables all three buttons.
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Encode button (ENCD)

The ENCD button functionality depends on the encoding mode you have selected
for each channel in the Command Center. Press the ENCD button to start
streaming or recording your selected input source(s) to the media or location
specified in the Command Center.

Pressing the ENCD button starts the streaming or recording. When streaming or
recording, the ENCD LED flashes. Press the ENCD button again to stop
streaming/recording.

You can also use the control buttons in the Command Center to control the
Monarch LCS device.

Note The ENCD button activates when you release the button. If you want to
start/stop streaming and/or recording on both channels at the same time, press
and hold the ENCD button. You can also start/stop both channels at once in the
Command Center (see “Using the Command Center side menu” on page 26).

ENCD button use differs depending on whether you are recording, or the stream
mode you selected in the Command Center:

e RTSP mode If Monarch LCS is set to stream in RTSP mode, the channel's
LED will be on (solid). The unit delivers stream data once the ENCD button
is pressed, and then the ENCD LED flashes, but the data will only start to
stream when a client connects to Monarch LCS using the RTSP streaming
protocol. Pressing the ENCD button enables a connection to the Monarch
device, and pressing it again will sever the connection and the LED will
return to the solid lit state.

* RTMP mode If Monarch LCS is set to stream in RTMP mode, press the
ENCD button to begin streaming your input source to the stream destination
specified in the stream settings.

* Record mode If the Monarch LCS is set to record, press the ENCD button
to begin recording your input source(s) to either an SD card, a USB device,
or a network folder, as specified in the record settings.

For information on specifying your settings, see “Settings page (Encoder tab)” on

page 39.
USB ports 1 and 2

Use the USB ports to connect a USB 2.0 or 3.0 media device for recording the
source connected to one of the Monarch LCS inputs. To select USB port 1 or 2 as
the recording destination, see “Settings page (Encoder tab)” on page 39.

Please note the following about using USB devices:

* Monarch LCS writes to all USB devices (including USB 3.0 devices) at USB
2.0 speeds.
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* The performance of USB keys or “thumb drives” varies. Many of these
devices are optimized for “read” operations, while the Monarch LCS
requires sustained “write” capabilities. For best results, especially at higher
recording data rates, powered USB drives are recommended. In some cases,
SD cards may be more suitable when small portable media is required.

* Monarch LCS supports USB devices with FAT32 or NTFS file systems.
Media may need to be reformatted if not recognized by the Monarch.

* USB devices with password protection are not supported.

* It may take a few seconds for Monarch LCS to detect a newly connected
USB device (verified on the Status page—see “Status page” on page 28).

* For USB 3.0 hard drives without a dedicated power supply, Monarch LCS
may not be able to sufficiently power more than one USB 3.0 drive at a time.

* When a recording is stopped, it may take a few moments for Monarch LCS
to finalize the file, during which the USB LED continues to flash. To avoid
corrupted video files, do not remove the USB device when its LED is
flashing.

* Connecting a USB device to USB port 2 and then performing a device reboot
allows you to save the Monarch’s current IP address and status as a text file
(see “Device reboot” on page 13).

* Connecting a USB device to USB port 2 and then performing a factory reset
allows you to load pre-configured Monarch settings.

SD card

Use the SD card slot for recording the source connected to one of the Monarch
LCS inputs to an SD card. Monarch LCS supports SD and SDHC cards with
FAT32 or NTFS file systems. To ensure that your SD card is fast enough to
record at higher bit rates, we recommend using an SD card with a Class 10 speed
rating. To select the SD card slot as the recording destination, see “Settings page
(Encoder tab)” on page 39.

Remarks
* It may take a few seconds for Monarch LCS to detect a newly inserted SD
card.

* When a recording is stopped, the SD card LED continues to flash while the
Monarch LCS finalizes the file. It is recommended to not remove the SD
card when its LED is flashing.

* SD cards with password protection are not supported.
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LAN

The LAN port is an auto-sensing 10/100/1000 Base-T Ethernet port used to
connect Monarch LCS to an Ethernet network via a standard RJ-45 Ethernet
cable. For information on how to connect to a network, see Chapter 3, “Network
Connection and Setup”.

RS-232

The RS-232 port is currently for internal use only.

Video/audio inputs and outputs

Matrox Monarch LCS supports both SD (SDI only) and HD video signals, and
auto-detects input source information; however, it does not support upscaling the
input source for streaming or recording.

Note If you apply the channel settings before the input is connected, and the
actual input resolution or frame rate is smaller than the resolution or frame rate
you specified in the channel settings, the Monarch will stream/record at the input
resolution/frame rate since upscaling is not supported. However, the Status page
will display the previously selected encoding resolution/frame rate, and not the
actual input resolution/frame rate.

HDMI out
Provides a preview of the selected SDI or HDMI input. For audio, you have the
following options:

* Use the first pair of embedded HDMI audio channels.

» Use the first pair of embedded SDI audio channels.

* Use the analog pair.
For more information, see “About the Audio section” on page 32.

To display your input source, your monitor must support the input resolution. If
your monitor does not, an error message will appear. For supported resolutions,
see “HDMI in A and B” and “SDI in”.

Note While SD resolutions are not supported at the HDMI output, if the SDI
input is SD, the HDMI output will display a “windowboxed” version of the
picture in HD.

HDMI in A and B

Provides an input for HD HDMI video (YUV or RGB) from a digital HDMI
device for streaming and recording. For information on supported HDMI input
formats, see “Supported input formats” on page 2.

Matrox Monarch LCS hardware
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@ Important Please note following:

» Before starting a session, it is recommended to unplug an input cable
connected to an unused input. An invalid signal can affect production (the
session).

* When using HDMI video, it is recommended to first use HDMI Input A.

Monarch LCS supports the first two channels of uncompressed embedded audio
from the HDMI input source for streaming and recording. HDCP and SD sources
are not supported on this input. You can monitor the HDMI input source by
connecting an HDMI monitor to Monarch LCS' HDMI output. To select whether
to stream and record the first two audio channels present in the HDMI input or
the audio connected to the Monarch LCS analog audio input, see “About the
Audio section” on page 32.

SDI out
Provides a preview of the selected SDI or HDMI input. For audio, you have the
following options:

» Use the first pair of embedded HDMI audio channels.
» Use the 16 SDI audio channels.

» Use the analog pair.
Note For more information, see “About the Audio section” on page 32.

To monitor your input source, the SDI monitor must support the video input
format.

SDI in

Provides an input for SDI video (YUV only) from an SDI device for streaming
and recording. For information on supported SDI input formats, see “Supported
input formats” on page 2.

Monarch LCS supports the first two channels of uncompressed embedded audio
from the SDI input source for streaming and recording. You can monitor the SDI
input source by connecting an SDI monitor to Monarch LCS' SDI output. To
select whether to stream and record the first two audio channels present in the
SDI input or the audio connected to the Monarch LCS analog audio input, see
“About the Audio section” on page 32.

AUX

The AUX connector is currently for internal use only.
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Analog audio output
Provides an unbalanced stereo analog audio output for monitoring the audio
selected as the audio input source.

Note There may be a slight offset between the HDMI, SDI and analog outputs.
Offsets can vary based on the source and operating mode.

Analog audio input

Allows you to input an unbalanced stereo analog audio source for streaming and
recording. To select whether to stream and record the first two audio channels
present in the selected video input or the audio connected to the Monarch LCS
analog audio input, see “About the Audio section” on page 32.

Powering Monarch LCS

Power the Monarch LCS device using an AC outlet via the external power supply
and a power cord. When power is supplied to Monarch LCS, the Power (d) )
LED goes on, and the device begins a power-up sequence during which various
LEDs will flash on and off. The Warning LED ( A) will begin to flash early
during the boot up sequence, and once it stops flashing, the Monarch LCS is
ready for use.

Note The Warning LED ( A) may remain on if there is an error condition (see
“Status page” on page 28 for more information).

To power off Monarch LCS, disconnect Monarch LCS from the power source.
For power specifications, see Appendix C, “Matrox Monarch LCS
Specifications”.

Note When the device is powered off, all current settings are maintained and
any logged errors are cleared (see “Monarch LCS errors” on page 29).

1"
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Using the Reset button
You can use the Monarch LCS Reset button to reboot the device (quick button
press), or reset the device to factory defaults (long press of at least five seconds).

In addition to the typical reasons for rebooting the Monarch (fixing errors or
other issues), a reboot (see “Device reboot” on page 13) also saves the Monarch’s
IP address and status (see “Status page” on page 28) to a connected USB device
(USB port 2) as a text file. This is a convenient way to find the Monarch’s IP
address.

A reset allows you to switch to a Static IP (see “Switch to Static I[P mode” on
page 13), or load pre-configured Monarch settings from a configuration file on a
USB device connected to USB port 2(see “Automatic Configuration” on

page 46).

Remarks
» The Reset button is recessed in order to prevent unintended activation. Use a
straightened paper clip, or similar device, to press the Reset button.

* A power cycle of the Monarch LCS performs a simple reboot, not a reset to
factory defaults.

* When using the Reset button, any saved profiles for streaming and recording
are maintained, and all logged errors are cleared (see*“Monarch LCS errors”
on page 29).
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* Holding the Reset button pressed for more than five seconds will reset the
device to factory defaults.

Device reboot
When performing a device reboot, all current settings are maintained, including
the IP mode (DHCP or Static) that was set prior to the reboot.

Note To reboot the device and switch to Static IP mode, see “Switch to Static
IP mode” on page 13”.

If you have a USB device connected to USB port 2 on the Monarch device, the
Monarch’s current IP address and status is saved to the USB device as a text file.
This is a convenient way to find the Monarch’s IP address.

To reboot Monarch LCS, do one of the following:

* Using a paper clip, press the recessed pinhole Reset button on the front of the
device.

* Open the Matrox Monarch LCS Utils application, select the Monarch LCS
device you wish to reboot, and then click Reboot Selected.

During a standard boot up sequence, various LEDs will flash on and off. The
Warning ( A\ ) LED will begin to flash early during the boot up sequence, and
once it stops flashing, the Monarch LCS is ready for use.

Switch to Static IP mode
You can switch your Monarch LCS device to Static IP mode by pressing the
ENCD button while the Encoder LED flashes during the power-up sequence.

1 Press the Reset button on the device to initiate a device reboot. During the
power-up sequence (see “Powering Monarch LCS” on page 11), the Encoder
LED flashes for three seconds.

2 Press the ENCD button on the device while the Encoder LED is flashing.
This sets the device to Static IP mode and the Static IP address to its default
address (169.254.1.11).

The device is ready when the Warning ( A) LED stops flashing; however, the
Warning LED ( A\ ) may remain on if there is an error condition (see “Status
page” on page 28 for more information).

13
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Reset to factory defaults

When resetting Monarch LCS using this method, all Monarch LCS settings reset
to factory defaults, the device password resets to admin, and the device powers
up in DHCP IP mode for connecting to a network with a DHCP server, such as a
router. To switch the device to Static IP mode after performing a factory reset, see
“Switch to Static IP mode” on page 13.

You can also use a factory reset to load pre-configured Monarch LCS settings
from a configuration file. For more information, see “Automatic Configuration”
on page 46).

To reset Monarch LCS to factory defaults, press and hold the Reset button on the
device for at least five seconds. The device begins a power-up sequence during
which various LEDs will flash on and off. The Warning ( A) LED will begin to
flash early during the boot up sequence, and once it stops flashing, the Monarch
LCS is ready for use.

The Warning LED ( A\ ) may remain on if there is an error condition (see “Status
page” on page 28 for more information.
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Status LEDs

This section explains the Monarch LCS status LEDs.

LED

State

Condition

O

Green

Device is powered.

A\

Yellow

Indicates that an error has occurred. This
includes streaming, recording, fan or
temperature-related errors, and/or a physical
disconnection of the network cable. The LED
turns off when the error is cleared in the
Command Center (e.g. streaming error) and
when the error has been resolved (e.g.
temperature-related error). For information on
how to view and clear errors, see “Monarch LCS
errors” on page 29.

INPUT
SELECT

Green (2)

Two LEDs, indicating which input is in use (A
or B): ON (solid) when HDMI is the selected
input, and flashes when SDI is the selected
input.

ENCD

OFF

The processes are idle.

Blue (solid)

The system is ready to record or stream.

Blue (flash)

The LED switches from solid to flashing blue
when you start a process, and will revert to solid
blue when you stop it, regardless of the mode.

Red (solid)

Indicates that both processes have failed.

Red (flash)

Indicates that one of the two processes has
stopped while the other is still running.

USB ports1/2
and SD CARD

OFF

Indicates that the port/slot is not selected.

Red (solid)

Indicates that the port/slot has been selected for
recording.

Red (flash)

Monarch LCS is currently writing to the media
device (USB device or SD card). Do not remove
the media device when its LED is
flashing—doing so may result in corrupted
video files.

15
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Network Connection and Setup

This chapter explains how to
connect Monarch LCS to a
network, and how to obtain the
Monarch LCS IP address to
access the Monarch LCS
Command Center. It also
explains how to update the
Monarch LCS firmware.
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Introduction

The network connection and setup instructions depend on whether you’ll be
connecting Monarch LCS on a network with a DHCP server, such as through a
router, or a network without a DHCP server.

If connecting to a network with a DHCP server, Monarch LCS must be set to
DHCP IP mode. If your network does not have a DHCP server, Monarch LCS
must be set to Static IP mode. By default, Monarch LCS is set to DHCP IP mode.
Once connected to a network, the stream and record settings are specified using
the Monarch LCS Command Center.

To access the Command Center, you can enter the network IP address of your
Monarch LCS device or use the Monarch LCS Utils application. When
connecting to a network with a DHCP server, the Monarch LCS IP address is
assigned by the DHCP server. In this case, you can use the Matrox Monarch LCS
Utils application to find the Monarch LCS IP address. When connecting to a
network without a DHCP server, you must assign a static IP address to Monarch
LCS. A default IP address is provided when in Static IP mode.

Monarch LCS Utils application

The Monarch LCS Utils application is available for both Mac OS and Windows
systems, and you can use it to do the following:

 Identify Monarch devices on a network and list their IP addresses.

* Open the Monarch LCS web based UI (Command Center) by
double-clicking an identified device on the displayed list.

» Update Monarch LCS firmware (see “Updating the Monarch LCS firmware”
on page 23).

* Reboot Monarch devices (see “Device reboot” on page 13).

Important Itis not recommended to simultaneously update the same Monarch
device using more than one instance of the Monarch LCS Utils. Do not sever the
network connection during the update process.

Network connection and IP address

This section explains how to connect Monarch LCS to a network with or without
a DHCP server, and describes how to acquire the Monarch LCS IP address.

Note If you switch the network connection while Monarch LCS is powered
and the switch results in Monarch LCS getting a new network IP address, you
must power cycle the device to apply the new IP address. To power cycle the
device, use the Reset button on the Monarch LCS device (see “Using the Reset
button” on page 12).
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Finding the Monarch LCS current IP address
You must know your Monarch device’s IP address to access the Command
Center. There are three ways to find the Monarch LCS current IP address:

* You can see it displayed on an HDMI monitor at device boot up.

* You can have it automatically saved to a connected USB device when
rebooting the Monarch LCS.

» Use the Monarch LCS Utils application to view all connected Monarch
LCSs and their IP addresses.

Displaying the IP address on an HDMI monitor
The Monarch LCS IP address is displayed on a connected HDMI monitor at
device boot up:

1 Connect the Monarch LCS to an HDMI monitor.
2 Power up the Monarch LCS.

When the Monarch LCS boots up, the IP address appears on the screen for
approximately 30 seconds before being replaced by the signal from the HDMI
output selection.

Saving the IP address and status to USB
You can save a file containing the Monarch LCS IP address and current status to
a USB device, making this information easily accessible (see “Status page” on
page 28).
1 Insert a formatted USB device into the USB port 2 (see “USB ports 1 and 2”
on page 7).

2 Reboot your Monarch LCS. It is complete once the Warning ( /A ) LED
stops flashing (see “Device reboot” on page 13).

The Monarch LCS IP address and status information are now saved to a text file
on the USB device.

This file can be helpful if you do not have an HDMI monitor (see “Finding the
Monarch LCS current IP address” on page 19), or if you need to share status
information for your unit.

Finding the IP address with Monarch LCS Utils

The Monarch LCS Utils application will indicate the IP addresses of the
Monarch devices in your network. See “Connecting to a network with a DHCP
server (DHCP IP mode)” for details.
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Connecting to a network with a DHCP server
(DHCP IP mode)

When connecting to a network with a DHCP server, such as through a router, the
Monarch LCS IP address is assigned by the DHCP server. Although other
methods exist for obtaining the IP address of a device on a DHCP server, such as
from a DHCP-server client list, these instructions detail how to use the Matrox
Monarch LCS Utils to find the IP address of your Monarch LCS device.

1

Connect an Ethernet cable between Monarch LCS LAN port and a network
port.

Make sure that power is supplied to Monarch LCS (see “Powering Monarch
LCS” on page 11).

Monarch LCS must be set to DHCP IP mode (default). If you need to switch
the device from Static IP mode to DHCP IP mode, you can either reset the
device to factory defaults (see “Reset to factory defaults” on page 14), or set
it to DHCP using the Command Center (see “IP Setup tab” on page 58).

From a computer that is on the same network subnet as your Monarch LCS
device, download the Matrox Monarch LCS Utils at
www.matrox.com/video/support/. The Matrox Monarch LCS Utils is
available for both Mac OS and Windows systems (see “Monarch LCS Utils
application” on page 18).

Double-click the downloaded file to open the Monarch LCS Utils. If
Universal Plug and Play (UPnP) is enabled on your network, the utility will
automatically scan for Monarch devices. To scan manually, click the Find
All button.

All the Monarchs on the same network subnet as your computer will be
displayed, along with their IP addresses and other information.

Open the Command Center (see “Accessing the Command Center” on
page 22).

Tip If you have multiple Monarch LCS devices, you may want to change the
name of each device for easier identification (see “Account tab” on page 55).
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Connecting to a network without a DHCP server
(Static IP mode)

When connecting to a network without a DHCP server, the network does not
assign an IP address to your Monarch LCS device. In this case, you must assign a
static IP address to Monarch LCS and you may be required to change your
computer’s network configuration to establish a connection between your
computer and Monarch LCS.

1 Power Monarch LCS (see “Powering Monarch LCS” on page 11).

2 Monarch LCS must be set to Static IP mode. By default, Monarch LCS is set
to DHCP IP mode. You can switch Monarch LCS to Static IP mode using the
Reset button (see “Switch to Static IP mode” on page 13).

3 Establish a connection between Monarch LCS and your computer using one
of the following methods:

— Connect an Ethernet cable from Monarch LCS LAN port directly to your
computer’s Ethernet port.

— Connect an Ethernet cable from Monarch LCS LAN port to the same
network switch as your computer.

4 In order for your computer to communicate with Monarch LCS, your
computer’s IP address must be in the same network range as your Monarch
LCS IP address. If it isn’t, then you must change your computer’s IP address
accordingly. By default, the Monarch LCS static IP address is set to
169.254.1.11. If you’re using the default static IP address, you must change
your computer’s IP address and subnet mask to the following:

— IP address 169.254.1.10
— Subnet mask 255.255.0.0

Note The default static IP address is designed primarily for the initial setup
of Monarch LCS using a point-to-point connection (direct connection between
your computer and Monarch LCS). The default IP address is not recommended
for a traditional network setting. If you wish to use Monarch LCS in Static IP
mode over a network, after the initial setup we recommend that you change
the static IP address of the Monarch LCS device to an address that is more
suitable to your network. You can change the static IP address in the Command
Center as specified in “IP Setup tab” on page 58.

5 Open the Command Center (see “Accessing the Command Center” on

page 22).
Note For more details on Monarch LCS IP modes, see “IP Setup tab” on
page 58.

Network connection and IP address
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Accessing the Command Center

The Monarch LCS Command Center is where you specify the Monarch LCS
settings and control the streaming and recording for a Monarch LCS device. The
Command Center is accessible via the Monarch LCS Utils (see “Monarch LCS
Utils application” on page 18) or by typing your Monarch LCS’ network IP
address in the address field of your web browser (see “Network connection and
IP address” on page 18).

To access the Command Center, power the Monarch LCS and connect it to an
Ethernet network, and then do one of the following:

* From your web browser, type the Monarch LCS IP address in the address
field, and then press ENTER.

» With Matrox Monarch LCS Utils open, double-click any of the listed devices
to open the Command Center.

The Command Center opens to configure your Monarch LCS settings and control
streaming and recording (see Chapter 4, “Using the Command Center”).

The Command Center opens on the Status page, which you can access without
logging in (see “Status page” on page 28). To access other pages, click the menu
item for the page that you want, and then enter your username and password. By
default, the username and password are set to admin. You cannot change the
username but you can change the password (see “Device name and password” on
page 55).
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Updating the Monarch LCS firmware

The firmware on your Monarch LCS device is updated using the Matrox
Monarch LCS Utils. To view the current firmware version of your Monarch LCS,
see “File Transfer tab” on page 62. The Matrox Monarch LCS Utils is available
for both Mac OS and Windows systems. For more information on the Utils
application, see “Monarch LCS Utils application” on page 18.

A Monarch LCS device’s network IP address is required to update its firmware
(see “Network connection and IP address” on page 18).

1 Power Monarch LCS and connect it to an Ethernet network.

2 On a computer that is on the same network subnet as the Monarch LCS that

you want to update, download the latest version of the Matrox Monarch LCS
Utils at www.matrox.com/video/support/.

Note It is not recommended to update the Monarch LCS firmware over a
wireless network. The Matrox Monarch LCS Utils should be on a computer
that is connected to the network/router using a wired Ethernet connection.

Double-click the MatroxMonarchLCSUtils.exe (Windows) or

MatroxMonarchLCSUtils.app (Mac OS) file to open the Monarch LCS Utils.

Open the Matrox Monarch LCS Utils, select the network IP Address of the
Monarch LCS device that you want to update, and then click Update
Selected. If you have multiple Monarch LCS devices on the network, select
the IP address for every device in the Matrox Monarch LCS Utils by clicking
Select All, and then all Monarch LCS devices will update in series.

Important Do not disconnect the Monarch LCS from the network or
power source during the firmware update.

During a firmware update, the USB 1, USB 2 and SD card LEDs will cycle
on and off. Once complete, the device will automatically reboot, and the
Warning ( A\ ) LED will begin to flash. Once it stops flashing, the device is
ready to use.

Note The Warning LED ( /A ) may remain on if there is an error condition
(see “Status page” on page 28 for more information).
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Using the Command Center

This chapter describes how to
specify settings in the Monarch
LCS Command Center, and

view Monarch LCS information.



26

Introduction

The Monarch LCS Command Center is a web-based application that allows you
to configure Monarch LCS settings, and control streaming and recording
sessions. This chapter is an overview of the features and sections of the
Command Center interface.

The Monarch LCS can be configured to capture and deliver content, such as
presentations and seminars, in a variety of layouts and formats. Monarch LCS
features one-click operation to start/stop streaming, recording, or both
simultaneously, from anywhere within the Command Center. There are different
operating modes to choose from, that allow you to deliver sources independently
or as a composited image.

Note You can enter the network IP address of your Monarch LCS device in
your browser, or use the Monarch LCS Utils to access the Command Center (see
“Accessing the Command Center” on page 22).

Using the Command Center side menu

With the Monarch LCS, both channels are started or stopped at the same time.
The appearance of the channel indicators change based on the selections you
make in the settings.

You can also control the Monarch LCS by using the buttons on the Monarch LCS
device. For more information, see Chapter 2, “Matrox Monarch LCS Hardware
and Connections”.

The following table details the different states of the control buttons/indicators.

Indicator only or

Indicator/Button Function

The channel indicators are marked as CH1 and CH2. They

CH 2 work as follows:

* Solid red: Ready to record.

* Solid blue: Ready to stream.

¢ Pulsing red or blue: Channel is currently recording or

streaming.
* Grey: Channel is set to “none” in the settings.

START

Controls

The Start and Stop buttons start or stop one or both
STOP channels depending on how the Monarch is configured in

the settings.
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Indicator only or
Indicator/Button

Function

Operating mode

DPERATLHG MODE

B [*B ]

ICTURE IN PICTU!

The operating mode area is a visual representation of the
operating mode the Monarch LCS is currently in.
Depending on the operating mode, this area can be a static
indicator only, or it can also be a button that performs
certain actions:

* Single Isolated: Status indicator only.

* Dual Isolated: Status indicator only unless you select
the option From Input A or B in the (HDMI Output)
settings, in which case this also becomes a button that
toggles between displaying Input A or B on the HDMI
output.

* Switcher: Status indicator and button that you use to
toggle between inputs.

* Picture-in-Picture: Status indicator and button that
you use to display or remove the PiP window.

* Side-by-Side: Status indicator only.

Indicates that the Monarch LCS is in Scheduler mode.

This indicator appears when the Monarch LCS is
transferring files.

Warning

Indicates that an error has occurred. This includes
streaming, recording, fan or temperature-related errors,
and/or a physical disconnection of the network cable.
Also, the Warning LED on the device’s front panel
illuminates when an error occurs. For more information,
see “Monarch LCS errors” on page 29.

Muting

PNy

The Mute button lets you mute the audio at any time while
streaming or recording, without interrupting your session.
Clicking the Mute button disables all audio.

You can also choose to not include the audio when
streaming or recording from within the channel settings,
before your session begins (see “Include audio” on

page 45).
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Indicator only or

Indicator/Button Function

Click the Lock button in the Command Center to lock the
Input Select, Switch and ENCD (encode) buttons on the
Monarch LCS device. This can prevent someone from
inadvertently switching inputs or stopping a streaming or
recording session.

By default, the front panel buttons are enabled (unlocked).
When required, this button-disabling feature must be
performed after a factory reset.

Lock

Status page

The Status page in the Command Center provides a summary of the Monarch
LCS status and settings, as well as any logged errors. You can view this page
without logging in; however, encoder information will display only when you
have logged in.

To access the Status page, open the Monarch LCS Command Center (see
“Accessing the Command Center” on page 22), and then click Status.

COMMAND CENTER Matrox’ Monarch"LCS|

on1 oz L sets

START Device name: MonarchLCs
Temperature status:  Normal  Fan status: Normal
STOP

Operating Mode: Dual Isolated

Video Inputs Selected: HDMI Az No video input  HDMI B: 1920x1080p, 29.97 fps
Audio Input Selected:  HDMI A: 48 kiz, 2 channels

Scheduler Enabled, LCS-Class 20Lics

Channel 1

Delivery mode: Record

OPERATING MODE
Video Channel Settings: 1024x576p, 30/25 fps, 1500 kby/s;
- Audio Channel Settings: 192 kb/s
DUALISO. Destination: USBL, no drive present.

Channel 2
Delivery mode: RTMP
Video Channel Settings: 720x480p, 30/25 fps, 5000 kb/s;
Audio Channel Settings: 102 kb/s
Destination:

Clear
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Monarch LCS errors
The Warning LED illuminates on the Monarch LCS device and the Warning icon
(/\) appears in the Command Center when an error occurs.

Remarks
» The Status page displays the errors pertaining to that Monarch LCS device
only.

* An error will not be reported if the audio connected to the Monarch analog
audio input is lost or missing. If this occurs, the stream and/or recording
continues, but will not contain audio.

* When you click the Clear messages button on the Status page, the logged
errors are deleted from the list, the Warning LED will turn off, and the
Warning icon will disappear if it is not a fan or temperature-related error (see
“Fan and Temperature errors”).

 If one of the channels unexpectedly fails and stops, for example, due to a full
storage device, while the other channel is still running, you can restart the
stopped channel from the Command Center once you have resolved the
issue.

@ Important Do not use the ENCD button on the front panel to restart the

process. Pressing the ENCD button while the other channel is running will
stop it, requiring that you restart both channels.

Streaming and recording errors

Streaming and recording errors are instantly logged in the Messages section of
the Status page. Clicking the Clear messages button on the Status page
deletes the logged error from the list, the Warning LED turns off, and the
Warning icon ( A\ ) disappears (see “Status page” on page 28). The Warning
LED will turn off, and the Warning icon ( /\ ) disappear also if you successfully
start a new stream and/or recording.

Note Powering off or resetting Monarch LCS will clear streaming and
recording errors from the device.

Fan and Temperature errors

The fan is located under the device, and a constant readout of both the fan and the
temperature statuses appear above the IMlessages section of the Status page. A
fan or temperature error will be indicated in this area as well. No fan or
temperature-related error message will be shown in the Messages section (see
“Status page” on page 28).

Important This error won't stop the device; however, we recommend that you
address the issue as soon as possible.
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The display reads “Normal” for the fan and temperature when the fan is operating
without a problem. If a fan and/or temperature error occurs, the status will change
to “Faulty” and/or “Critical”. The error status will remain as long as a problem is
detected and has not been resolved. The Warning LED will turn off and the
Warning icon ( A\ ) will disappear when the condition is corrected, and the
Status page will automatically update the fan/temperature status back to
Normal.

The temperature may come down on its own over time, and so the Warning LED
will turn off, the Warning icon disappear, and the fan and temperature statuses
will return to Normal; however, the Warning LED will light up, the Warning icon
reappear in the Command Center again and the error status will display (above
the Messages section of the Status page) if/when the temperature rises once
more.

The fan operates as an uptake under the device. For good fan operation, ensure
that the device is not placed on top of paper, and that it is used in an area with
adequate air circulation. If a fan or temperature error occurs:

* Check that the fan is spinning and is unobstructed.

* Verify that the area has suitable sufficient ventilation and that the ambient
temperature has not risen.

Settings page (Production tab)
The Production tab of the Settings page lets you set the Monarch LCS
operating mode and configure the related settings.
@ Important Please note the following:
» If you leave the Settings page before clicking Apply, all changes will be
lost.
* Do not connect or disconnect any cables to the Monarch LCS while settings
are being applied.

To access the Production tab, open the Monarch LCS Command Center (see
“Accessing the Command Center” on page 22), click Settings, and then click
Production.
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COMMAND CENTER

Encoder Savelload

Operating Mode _-
Single Isolated W

Input

® Hp!

Osor

SDIO

® Fro

Fro

HDMI

® Fro

Status .

About the Operating Modes
There are five different Monarch LCS operating modes: Single Isolated, Dual
Isolated, Switcher, Picture-in-Picture, and Side-by-Side.

Depending on the Operating Mode you select, the settings under the Video and
Audio sections will change, and certain modes (e.g. Picture-in-Picture) will add
a Layout section.

The following are conditions where the final frame rate options are limited:
* In Dual Isolated mode, when your sources are at 50 or 60 fps, your (HDMI
out) preview (of the sources) will display at 30 fps.

¢ In Dual Isolated, Switcher, Picture-in-Picture, and Side-by-Side
operating modes, the encoding frame rate is dependent on the frame rate of
the Input A source. For more information on frame rates, see “Frame rate”
on page 44.

@ Important Please note the following:

» Before starting a session, it is recommended to unplug an input cable
connected to an unused input. An invalid signal can affect production (the
session).

» Itis recommended that interlaced sources always be connected to Input A.

Settings page (Production tab)
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About the Video section

The Video section includes the selectable video input and output settings. You
can switch between inputs in the Command Center; however, only after a
streaming or recording session has been stopped. If you attempt to switch the
inputs while encoding, the stream/recording will have to be stopped, and the
session will have to be restarted to encode from the new input.

About the Audio section

The Audio section is where you set the source for your audio input (Analog or
Digital), the sample rate, and the bit rate. Monarch LCS supports a stereo pair of
audio for streaming and recording, and whether you are using an SDI or HDMI
source, only the first two channels are selected by the device for encoding (see
“Video/audio inputs and outputs” on page 9). However, all 16 audio channels
from SDI sources are available when output through SDI out. Monarch LCS uses
the AAC audio format for streaming and recording. To monitor the selected audio
source, you can use any of the audio outputs (SDI, HDMI or analog).

Please note the following about the Audio settings:

* Sample Rate. You can select the desired sample rate for either your digital
or analog audio input source.

— Both digital (HDMI or SDI) and analog audio can be sampled, or
re-sampled at the embedded rates of 22.05, 24, 32, 44.1 and 48 kHz.

— The analog audio input is converted to the selected sample rate before
encoding.

— Selecting the highest sample rate provides the best audio quality, but also
increases the total bit rate required to maintain this quality for streaming
and/or recording.

» Bit Rate. You can select the bit rate at which you want to stream or record
the audio. Your bit rate selection can have an effect on the sample rate.

— The selectable audio bit rates are: 32, 96, 128, 192, and 256 kb/s.

Configuring Single Isolated mode

In Single Isolated mode, a single input source can be scaled and encoded by one
or both encoders, before it is processed to one or two independent targets.
Although processed independently, two channels are always started and stopped
synchronously. Your input selection cannot be changed while the unit is
operating.
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COMMAND CENTER [Matrox' Monarch”LCS]|

nnnnnnnnnnnn

Operating Mode —EEEE— T

STOP
Single Isolated v/

InputA:  Input B:
®+HDME OHDM
soI

SDI Output:
® From Input A

From Input B

HDMI Output:
® From Input A
From Input 8

To configure Single Isolated mode:
1 Under Video, select your video input source. You can select either Input A
(HDMI or SDI) or Input B.

The SDI Output and HDMI Output settings are unavailable in this mode,
but you will still see the settings change based your input source
selection—all outputs (HDMI or SDI) display your incoming video signal.

2 Under Audio, select your audio input source (analog or digital) and
configure the Sample Rate and Bit Rate.

3 Click Apply.

The Operating Mode is configured. In the Command Center’s side menu, the
Operating Mode indicator is static.

For more information, see the following sections:

» “Using the Command Center side menu” on page 26.
» “About the Operating Modes” on page 31.

* “About the Video section” on page 32.

» “About the Audio section” on page 32.

Configuring Dual Isolated mode

In Dual Isolated mode, two inputs can be scaled and encoded simultaneously.
Although processed independently, the two processes are always started and
stopped synchronously. The two processed inputs always include the HDMI B
input and either the SDI A or HDMI A input.

Settings page (Production tab)
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COMMAND CENTER [Matrox' Monarch”LCS]|

[ starT ] i

— Operating Mode
STOP.

Dual Isolated v

InputA:  Input B:
®HDMI  © HDM
soI

SDI Output:
® From Input A Sample Rate:

From Input L

Bit Rate:

HDMI Output: kb/s
o

Note It is recommended to record to the same destination when recording in
Dual Isolated mode.

To configure Dual Isolated mode:

1 Under Video, configure the following:

a Select your video input sources. For Input A you can select either HDMI
or SDI.

b For SDI Output, specify whether your output is coming from Input A or
Input B.

¢ For HDMI Output, specify whether your output is coming from Input A,
Input B, or from both. If you select From input A or B, the Operating
Mode indicator in the Command Center side menu becomes a button that
can toggle between inputs dynamically.

2 Under Audio, select your audio input source (analog, digital input A or
digital input B) and configure the Sample Rate and Bit Rate.

3 Click Apply.

The Operating Mode is configured. In the Command Center’s side menu, the
Operating Mode indicator shows the status, but can also be a button that affects
the video output. The button can be used to preview either Input A or B.

For more information, see the following sections:

» “Using the Command Center side menu” on page 26.
» “About the Operating Modes” on page 31.
» “About the Video section” on page 32.
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* “About the Audio section” on page 32.

* “Record mode” on page 40.

Configuring Switcher mode

In Switcher mode, you can perform a full-frame dynamic switch from one video
input to the other. Although processed independently, the two channels are
always started and stopped synchronously.

COMMAND CENTER [Matrox' Monarch”LCS]|

uuuuuuuuuuuu
[HCHA [ CH2 Producti Encoder SavelLoad
START :
STOP
InputA:  Input B: ce:
®HOMI © HDM
so1 =
From digital Input 8
SDI Output:
® From Input A Sample Rate:
From Input L
Bit Rate:

HDMI Output: kb/s
rom In

To configure Switcher mode:

1 Under Video, configure the following:

a Select your video input sources. For Input A you can select either HDMI
or SDI.

b For SDI Output, specify whether your output is coming from Input A or
Input B.

¢ For HDMI Output, specify whether your output is coming from Input A
or Input B, or if you want a Channel preview. If you select Channel
preview, the HDMI output will display the video at the resolution of the
streaming/recording output, allowing you to view what the remote viewer
will receive.

2 Under Audio, select your audio input source (analog, digital input A or
digital input B) and configure the Sample Rate and Bit Rate.

3 Click Apply.

The Operating Mode is configured. In the Command Center’s side menu, the
Operating Mode indicator shows the status, but is also a button to dynamically
switch between video inputs.

Settings page (Production tab)



36
For more information, see the following sections:

* “Using the Command Center side menu” on page 26.
» “About the Operating Modes” on page 31.

* “About the Video section” on page 32.

» “About the Audio section” on page 32.

Configuring Picture-in-Picture mode

In Picture-in-Picture mode, Monarch LCS composites two video input sources,
encodes them, and then streams/records them to one or two different destinations.
Although processed independently, the two channels are always started and
stopped synchronously. The two processed inputs always include the HDMI B
input and either the SDI A or HDMI A input, where Input A is overlaid on top of
Input B.

COMMAND CENTER [Matrox' Monarch”LCS]|

nnnnnnnnnnnn

Production Encoder SavelLoad

Operating Mode —EEEE— T
.
o

STOP.

InputA:  Input B:
®HDMI  © HDM
soI

uuuuuuuuuu
From digital Input 8

SDI Output:

® From Input A Sample Rate:

From Input L

HDMI Output:
From Input A

To configure Picture-in-Picture mode:

1 Under Layout, configure the following:
a Click on the type of picture-in-picture format you want to display.

b (Optional) Select Center crop Input A if you want to crop 25% of the
left and right sides (giving you an 8:9 aspect ratio) of an HD Input A
video signal.
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2 Under Video, configure the following:

a Select your video input sources. For Input A you can select either HDMI
or SDI.

b For SDI Output, specify whether your output is coming from Input A or
Input B.

¢ For HDMI Output, specify whether your output is coming from Input A
or Input B, or if you want a Channel preview. If you select Channel
preview, the HDMI output will display the video at the resolution of the
streaming/recording output, allowing you to view what the remote viewer
will receive.

3 Under Audio, select your audio input source (analog, digital input A or
digital input B) and configure the Sample Rate and Bit Rate.

4 Click Apply.
The Operating Mode is configured. In the Command Center’s side menu, the

Operating Mode indicator shows the status, but is also a button to dynamically
turn the Input A overlay on and off.

For more information, see the following sections:

» “Using the Command Center side menu” on page 26.
* “About the Operating Modes” on page 31.

» “About the Video section” on page 32.

* “About the Audio section” on page 32.

Configuring Side-by-Side mode

In Side-by-Side mode, Monarch LCS composites two video input sources,
encodes them, and then streams/records them to one or two different destinations.
The inputs are positioned side-by-side in one of four ways, two of which allow
for a cropped Input A.

Settings page (Production tab)
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COMMAND CENTER [Matrox' Monarch”LCS]|

uuuuuuuuuuuu
[HCHA [ CH2 Production Encoder SavelLoad
START 5
STOP
SidebySide v
InputA:  Input B: Audio Source:
®HDMI  © HDM From analog Input
e ® From digital Input A
From digital Input 8
® From Input A Sample Rate:

From Input L

“ “ HDMI Qutput:

From Input B

® Channel preview

Although processed independently, the two channels are always started and
stopped synchronously. The two processed inputs always include the HDMI B
input and either the SDI A or HDMI A input.

To configure Side-by-Side mode:

1 Under Layout, click on the type of side-by-side format you want to display.
2 Under Video, configure the following:
a Select your video input sources. For Input A you can select either HDMI
or SDI.
b For SDI Output, specify whether your output is coming from Input A or
Input B.
¢ For HDMI Output, specify whether your output is coming from Input A
or Input B, or if you want a Channel preview. If you select Channel
preview, the HDMI output will display the video at the resolution of the
streaming/recording output, allowing you to view what the remote viewer
will receive.
3 Under Audio, select your audio input source (analog, digital input A or
digital input B) and configure the Sample Rate and Bit Rate.

4 Click Apply.

The Operating Mode is configured. In the Command Center’s side menu, the
Operating Mode indicator shows the status only, but that status reflects whichever
format you chose to display.
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For more information, see the following sections:

* “Using the Command Center side menu” on page 26.
» “About the Operating Modes” on page 31.

* “About the Video section” on page 32.

» “About the Audio section” on page 32.

Settings page (Encoder tab)

The Encoder tab on the Settings page in the Command Center lets you set
stream and record settings for the Monarch LCS. Monarch LCS has several
presets that can speed up the start of a project, meaning that you do not have to
recall every parameter for repeated channel settings (see “Presets”).

@ Important Please note the following:

» If you leave the Encoder page before clicking Apply, all changes will be

lost.

* Do not connect or disconnect any cables to the Monarch LCS while settings

are being applied.

To access the Encoder tab, open the Monarch*“Record mode” on page 40 LCS
Command Center (see “Accessing the Command Center” on page 22), click

Settings, and then click Encoder.

COMMAND CENTER

CHANNEL STATUS

Matrox’ Monarch”LCS)|

CH1  |eH2s Production SavelLoad
START
Mode: Open Capture V|
[ (o) | preset
Resolution: [1024 | w H
Frame rate (fps);: [30/25__ W|No video input
oreraTING MoDE
Target Data Rate (kb/s): 1500
DUALISO
'V Advanced Settings
Gopstructure: [30__| frames
Profile
Frame sices:

Min Target Data Rate (kb/s):
Max Target Data Rate (kb/s):
Deblocking filter: []

Settings
Device Media:

e e
Max. recording duration: [0 |hed|min

Filetype:  @wmov Ompa

Path and filename: [File

Open Capture XML information

User ID: Name{Monarchl CS

L camne 2 py

o
Preset: [None v
Resolution w [0 u
Frame rate (ips) 1920x1080, 0 fps
Target Data Rate (kbys):
Include audio: I
GOP structure: [10__|frames
Profile:
Frame slices
Min Target Data Rate (kb/s):
Max Target Data Rate (kb/s):
Deblocking filter: [

Comnecton cade ]

The Monarch LCS has three encoding modes with their own options and
capabilities: Record, RTMP (streaming), and RTSP (streaming).

Settings page (Encoder tab)
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Record mode

Record mode saves the source to a USB device, an SD card, or to a network
shared folder. Recordings can be done at different bit rates in case you need to
deliver content to devices with varying decoding capabilities.

When you select Record, an additional drop-down menu appears with the
following selections:

Default The default recording behavior (no Open Capture XML files created).

Open Capture Creates an XML file that is compatible with the Open Video
Capture standard on the destination media. For more information, see “Open
Capture option”.

When a recording is stopped, it may take a few seconds for Monarch LCS to
finalize the file. If you are recording to a USB device or SD card, the USB/SD
card LED continues to flash during the finalization process. To avoid corrupted
video files, do not remove the USB device or SD card when its LED is flashing.

Monarch LCS provides settings for recording your input source for video on
demand (VOD), high-quality editing, and archiving/previewing purposes.
Content can be recorded to MOV and MP4 file formats on a FAT32 or NTFS file
system.

Note If you need to record files exceeding 4 GB, an NTFS drive should be
used. For approximate recording file sizes based on the average video data rate
and recording duration, and approximate maximum file durations given the
average video data rate and available disk space, see Appendix A, “Recording
file size and duration”.

Open Capture option
Selecting Open Capture from the drop-down list creates an XML file that is
compatible with the Open Video Capture standard on the destination media.

When recording using the Open Capture option, the Destination section of the
Encoder tab displays User ID and Name fields. Enter your Open Capture
account (e.g. Kaltura) credentials in the User ID field. Open Capture software
uses this ID to transfer the video to the correct location on their servers.

By default, the Name field is populated with the Monarch LCS device name. It is
the Name, followed by the date and time of the recording that is found in the
Open Capture XML file (created when Open Capture is selected),

If you are using something other than the Monarch device’s name in the Name
field, note that a factory reset will set it back to the Monarch device’s name.
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The Open Capture option is set individually per encoder in all modes, with the
exception of Dual Isolated mode. In Dual Isolated mode, note the following:

* When Open Capture is selected on both encoders, you only need to enter

the User ID information under Encoder 1, as the field is grayed out for
Encoder 2.

If Open Capture is selected for only one of the two encoders, then the
associated Open Capture XML file is saved on the destination media of the
encoder with the Open Capture option selected. Otherwise, if Open
Capture is selected for both encoders, the Open Capture XML file is saved
on the destination media for Encoder 1.

It is recommended to record to the same destination when recording in Dual
Isolated mode. For more information, see “Configuring Dual Isolated
mode” on page 33.

Remarks

* File segmentation is not supported when recording with the Open Capture

option. For more information, see “File Segment Duration” on page 51.

* Open Capture XML metadata files are also transferred when using the File

Transfer feature; however, the Monarch will only transfer the files found on
the selected media (even if a video referenced in the Open Capture XML file
is located on another USB/SD card).

When recording Open Capture files in Dual Isolated mode where video
files are recorded to two different media (USB/SD card), it is recommended
that both files be recorded on the same media so that, when needed, the
transfer of all associated content be done in the same process.

If it is not possible to record to the same drive, in order to minimize the
chance of creating “orphan” Open Capture XML or video files in file
transfer destination folder, it is recommend that you transfer each Open
Capture XML file as soon as possible following the transfer of the parent
video file(s).

Note For more information on transferring, see “File transferring” on
page 62.

RTMP and RTSP streaming modes

There are two types of streaming standards available:

* RTMP Real-time Messaging Protocol: A popular protocol for transmitting

audio, video, and data with Flash media.

* RTSP Real-time Streaming Protocol: A network control protocol for

media servers, controlling media sessions between end points.

a1
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Note For the maximum frame rate for streaming or recording, see “Target
video data rate” on page 45.

RTMP streaming options
When RTMP mode is selected, another drop-down exposes three selections:

Default Streams with an optimized methodology for communicating with
RTMP servers (recommended for most RTMP streaming).

Legacy This uses a RTMP streaming protocol identical to those used in older
Monarch releases (use this option if you have difficulty using Default with
another RTMP protocol).

Wowza Cloud RTMP protocol optimized for Wowza Cloud account users.

The Wowza Cloud option uses the Wowza token mechanism to establish secure
communications through the Wowza streaming cloud. The token is a code used to
connect.

Mode: |RTMP | |LIEIEEREGTE] v

preset;
Resolution: W H

Frame rate (fps): |30/25 [ 1920x1080, 0 fps
Target Data Rate (kb/s): (5000

Include audio:

[ WV Advanced Settings ]

v
GOP structure: frames

Profile: |High v
Frame slices:
Min Target Data Rate (kb/s):
Max Target Data Rate (kb/s):
Deblocking fitter.  []
Connection Code: I:I

When you select Wowza Cloud, a Connection Code (Wowza token) field
appears under the Destination section. You will have to enter all connection
information (login, password, stream name, location, URL, etc) in your Wowza
Cloud account.

Once you are provided a token, enter the code in the Connection Code field.
Click Apply. Once the Monarch LCS confirms the code, the Connection Code
field displays the code with “Authenticated” beside it and a Deactivate button
appears.
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Press the Deactivate button to clear the code currently being used. Wowza
connection codes are valid for only 24 hours.

Connection Code: Authenticated

If the Monarch LCS is unable to make a connection (e.g. invalid code or lack of a
network connection), an error message will display and “Failed” appears beside
the Connection Code field. If the Wowza code is invalid, a message will also be
a message on the Status page.

Connection Code: Failed

Note Performing a device reset will also clear the code.

Presets

Monarch LCS is preloaded with several encoding presets that define all the
encoding parameters, including resolution and bit rate. A preset automatically
sets all channel settings. Whether streaming or recording, you can also use a
preset as a starting point when specifying your channel settings:

* Monarch LCS provides standard presets for streaming and recording
operations; however, some presets may not be compatible for use with all
CDN:s. To avoid streaming issues, ensure that a preset’s settings, such as
video resolution and video data rate, are supported by your CDN.

* Besides standard presets, Monarch LCS provides the following recording
preset types:

— HQ Used for creating recorded files that will be edited for high-quality
production.

— Proxy Suitable for creating recorded files at smaller file sizes. This is
especially useful when creating files for previewing or archiving, or when
recording long-duration content.

Use a preset by selecting one from the Preset list.

Note It is recommended that you select one of the 4:3 presets when encoding
standard definition sources.

Resolution

You can select the stream/record resolution you want by entering values for the
width and height. The Monarch LCS does not support upscaling the resolution or
frame rate of the input source (for streaming or recording).
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Note If you apply the channel settings before the input is connected, and the
actual input resolution is smaller than the resolution you specified in the channel
settings, the Monarch will stream/record at the input resolution since upscaling is
not supported. However, the Status page will display the previously selected
encoding resolution, and not the actual input resolution.

Frame rate

Using the Frame rate drop-down list, you can choose to stream or record at your
input source's frame rate, or at a lower frame rate. The Monarch LCS does not
support upscaling the resolution or frame rate of the input source (for streaming
or recording).

Note For the maximum frame rate for streaming or recording, see “Target
video data rate” on page 45.

The following table lists the frame rates (in fps) and their associated Command
Center selections:

Source Command Center Encoded
Frame rate Selection Frame rate
60/50 59.94 or 60
59.94 or 60 30/25 29.97 or 30
15/12.5 14.98 or 15
60/50 50
50 30/25 25
15/12.5 12.5
30/25 29.97 or 30
29.97 or 30
15/12.5 14.98 or 15
30/25 25
25
15/12.5 12.5

Note Prior to connecting your input source, if you select 60/50 as the frame
rate, but your source is only 30, 29.97 or 25 fps, the Frame rate selection will
switch to the source's frame rate (30/25 - see the table above) when the source is
connected. The Status page will display the previously selected encoding frame
rate, and not the actual input frame rate.
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Target video data rate

Enter the target video data rate for your recording (average data rate). The default
minimum and maximum values (see “Minimum and Maximum target video data
rates” on page 46) are suitable in most instances, however, you can change the
minimum and maximum values to suit your needs. When entering an average
data rate, the Minimum and Maximum target video data rates are automatically
set to 90% and 110% of the target video data rate, respectively. The maximum
average video data rate for streaming or recording depends on the encoding mode
(see “Record mode” on page 40 and “RTMP and RTSP streaming modes” on
page 41). Monarch LCS uses a variable data rate when encoding.

The maximum selectable video bit rates are as follows:

* 16 Mb/s (streaming or recording) when only one encoder is in used.
* 8 Mb/s (streaming) when two encoders are in used.

* 10 Mb/s (recording) when two encoders are in used.

For a more detailed breakdown, consult the following table:

Encoder 1 Encoder 2 M(ah);ik:‘;sl;m
Streaming 16 Mb/s None 16
Streaming 8 Mb/s Streaming 8§ Mb/s 16
Streaming 8§ Mb/s Recording 10 Mb/s 18
Recording16 Mb/s None 16
Recording 10 Mb/s Streaming 8 Mb/s 18
Recording 10 Mb/s | Recording 10 Mb/s 20
None Streaming 16 Mb/s 16
None Recording 16 Mb/s 16

Include audio

You must select Include audio to stream/record the selected audio source (see
“About the Audio section” on page 32) along with the video. If you want to
change this setting, you must do so before starting a streaming/recording session;
otherwise, you will need to stop the session, make the change, and then restart.

Note Monarch LCS uses the AAC audio format for streaming and recording.
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Advanced settings

GOP structure
Enter the GOP structure (distance between I frames) to which you want to
encode your input source for streaming or recording.

Note Monarch LCS uses the IP pattern when encoding. For example, a GOP
structure of 10 creates a GOP of IPPPPPPPPPI.

Profile

Set the H.264 encoder profile for your stream or recording to either Baseline,
Main, or High. Typically, the High profile provides the best image quality and is
suitable in most instances. However, depending on the decoder used when
viewing the stream or the recorded file, such as with mobiles devices, a Main or
Baseline profile may be required.

Frame slices

You can choose to slice each frame into 2, 4, or 8 sections when encoding, or you
can select 1 to encode the frame as a whole. Slicing each frame when encoding
the video for streaming or recording may be useful when a multi-slice decoder
device is used to view the stream or recorded file.

Minimum and Maximum target video data rates

The Minimum and Maximum video data rates are automatically set to 90% and
110% of whatever you set as the target video data rate. For more information on
minimum and maximum video data rates and how they are used with the Target
video data rate, see “Target video data rate” on page 45.

Deblocking filter

Select this option to remove blockiness from the encoded video when streaming
or recording. This option is especially useful when a low video data rate is
required (see “Target video data rate” on page 45).

Destination settings (streaming)

Monarch LCS provides options for using RTSP and RTMP streaming protocols
for use on Adobe Media Servers, Wowza Media Servers and Streaming Cloud,
software video players such as VLC, or any of the popular Content Delivery
Networks (CDNs), such as YouTube Live and Ustream. In RTSP mode, Monarch
LCS acts as a streaming server to which clients can connect via a media server, or
software video player that supports the RTSP streaming protocol. If you want to
stream to more than a handful of clients, we recommend using a dedicated media
server to send streams to clients. In RTMP mode, Monarch LCS can send stream
data to a media server that supports the RTMP streaming protocol.
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Using the RTSP streaming protocol

1

2
3
4

Select RTSP mode.
Enter a Stream name.
Enter the network Port through which the clients will connect.

A Stream URL is automatically generated based on your settings. Provide
this URL to a client to connect to your Monarch LCS network via a Wowza
Media Server or software video player that supports the RTSP streaming
protocol.

(Optional) Enable jumbo frames. Enabling jumbo frames changes the IP
packet size of the stream from 1500 bytes to 9216 bytes. This option may
improve performance on certain networks; however, not all networks support
larger packet sizes. This option is disabled by default.

Remarks

In RTSP mode, Monarch LCS will only start streaming data to clients once
the ENCD button on the front panel or the Start button in the Command
Center is pushed. The streaming will continue until it is stopped, by pressing
the ENCD button or the Stop button in the Command Center, once more
(see “Using the Command Center side menu” on page 26).

If you get choppy video when streaming to VLC media player, you must
enable the Real-time Transport Protocol (RTP) in VLC. Proceed by doing
one of the following:

— Windows Open the VLC media player, open Tools > Preferences,
and then choose the Input / Codecs tab. In the Network section, select
RTP over RTSP (TCP).

— Mac Open the VLC media player, open VLC > Preferences, and then
choose the Input / Codecs tab. In the Codecs / Muxers section, select
Use RTP over RTSP (TCP).

Using the RTMP streaming protocol

1

Select RTMP mode.

2 Click Browse... to load the Server URL and Stream name from an XML

file (Wowza Streaming Engine or Adobe Flash Media Live Encoder file
only), or enter the Server URL and Stream name manually in the fields
provided. You can only load destination information (server URL and stream
name) from an XML file. Encoding information will not be loaded. Clear the
Server URL field to remove the XML file. Clear the Stream name field to
remove the loaded streaming XML file.

Important Please note the following:

— If the stream name, username, or password is included in the stream URL,
do not enter the information in the respective text boxes.
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— Streaming XML files are not the same as Monarch HD configuration
XML files.

3 If your Flash-based server or CDN uses the “ModuleRTMPAuthenticate”
method for RTMP authentication, a username and password are used for
authentication, however, username and password information is not included
as part of the stream URL or streaming XML file. In this case, you must
enter the stream Username and Password in the text boxes provided.

4 Start streaming the Monarch LCS input source to a CDN or media server.

Note For the maximum frame rate for streaming or recording, see “Target

video data rate” on page 45.

Destination settings (record)
Specify the following settings for recording:

Media
Select the media to which you want to record your input source. You can choose
either a USB or SD card slot on the Monarch LCS device, or a network location.

For more information on using USB devices or SD cards, including the known
limitations of each, see the sections “USB ports 1 and 2” on page 7, and “SD
card” on page 8.

Save file as
The Save file as option allows you to choose the filename format of your
recorded files. You can choose from three formats:

* Filename only Uses your specified filename to identify recorded files
(e.g. Basename.mov/mp4). If a recording session results in a file being
segmented into multiple files, a three-digit incrementing number (starting at
001) will also be added to the filename from the second file onwards (e.g.
Basename001.mov/mp4, Basename002.mov/mp4, etc).

The three-digit value is needed to differentiate between the multiple files
created by file segmentation. For more information on how file segmentation
works, see “File Segment Duration” on page 51.

® Warning

— If you use this filename format, you must make sure to change the
filename before manually starting a new recording, otherwise the old
recorded file will be overwritten. A recording is manually started by
pressing the ENCD button on the device or by clicking the Start button in
the Command Center.
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— Do not use the Filename only option if you plan on consolidating your
files with the Matrox File Consolidator. Because the filename differs from
the second file onwards, the consolidator will not be able to recognize that
the segmented files are part of the same recorded sequence.

Filename with date/time Uses your specified filename, adds the start
date/time of the recording session, and adds a three-digit number that
increments when file segmentation occurs (e.g.
Basename-[YYYY-MM-DD_HH-MM-SS ]-000.mov/mp4). For more
information on how file segmentation works, see “File Segment Duration”
on page 51.

If file segmentation occurs, each file will have the same date/time in the file-
name; that is, the start date/time of the first file in the sequence. The
three-digit incrementing number is then used to differentiate the files.

For example, a recording that is segmented into three (3) files will result in
the following:

— MyRecordedFile-[2015-12-01_13-30-45 ]-000.mov/mp4
— MyRecordedFile -[2015-12-01_13-30-45]-001.mov/mp4
— MyRecordedFile -[2015-12-01_13-30-45 ]-002.mov/mp4

The date/time in the filename only changes when you manually stop a re-
cording and then start a new one, in which case it will be the start date/time
of the first file in the new sequence.

Filename with numeric counter Uses your specified filename, adds a
two-digit number that increments when you manually stop/start the
recording, and adds a three-digit number that increments when file
segmentation occurs (e.g. Basename00000.mov/mp4). For more information
on how file segmentation works, see “File Segment Duration” on page 51.

The two-digit number increments with each manual stop/start of the record-
ing, up to 99 times, after which it resets to 00. As with date/time, this number
does not increment with file segmentation. For example, if you have three (3)
files that you created by manually starting and stopping the recording ses-
sion, it will result in the following:

— MyRecordedFile00000.mov/mp4
— MyRecordedFile01000.mov/mp4
— MpyRecordedFile02000.mov/mp4
The three-digit number increments when file segmentation occurs. For ex-

ample, a recording that is segmented into three (3) files could look as fol-
lows:
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— MyRecordedFile00000.mov/mp4

— MpyRecordedFile00001.mov/mp4

— MyRecordedFile00002.mov/mp4

Another example would be if you have multiple files created by manual
stop/start, and only the third file is segmented into two additional files. That
would look as follows:

— MyRecordedFile00000.mov/mp4

— MpyRecordedFile01000.mov/mp4

— MyRecordedFile02000.mov/mp4

— MpyRecordedFile02001.mov/mp4

— MyRecordedFile02002.mov/mp4

@ Important Blank spaces are not supported in the base name. Use underscores

in place of blank spaces. For example, enter Recordingl_Stagel instead of
Recordingl Stagel as the base name for the file.

Maximum recording duration

Enter a duration to set an overall time limit for your recording session. The
session will automatically end when this limit is reached, or when the selected
storage media is full (whichever occurs first). If you enter a value of 0, the
recording session will continue indefinitely until manually stopped; otherwise, it
will stop only when your storage media is full. This setting represents your
desired recording length. The actual length is determined by the size of your
storage device.

Note The number of files created at the end of the session is dependent on the
overall length of your recording session and whether or not you have entered a
value in the File Segment Duration fields (see “File Segment Duration” for
more information).

Assuming the storage media has enough space, an entry in the Maximum file
duration field will result in the Monarch LCS creating multiple recording files
when:

* You have entered a maximum recording duration longer than 4 hours and 50
minutes.

* You have entered a file segment duration of 0, and your recording lasts
longer than 4 hours and 50 minutes.

* You have entered a file segment duration longer than 1 minute.
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File Segment Duration

If you enter a duration in the File Segment Duration fields (hr and/or min), at
the specified interval, the Monarch LCS will create a new file, splitting your
recording session over multiple files. For example, if you enter a duration of 30
minutes, Monarch LCS will close the current file and start recording to a new file
every 30 minutes.

The maximum file segment duration you can set is 4 hours and 50 minutes. If you
leave the setting at the default duration of 0, the Monarch LCS will automatically
switch to a new file every 4 hours and 50 minutes.

The size of the created files (in approximated MBs) is displayed next to the
duration. The file size adjusts depending on the video data rates you set in the
encoding options (see “Target video data rate” on page 45).

Important Please note the following:

* On FAT32 storage media, file segmenting will occur automatically after 4
GB.

* Because FAT32 limits the recording file size to 4 GB, you must use an NTFS
drive if your recording file will be greater than 4 GB.

* File segmentation is not supported when recording with the Open Capture
option. For more information, see “Open Capture option” on page 40.

File type
Select the type of file that will be recorded. You can create either an MOV or
MP4 file.

Path and filename

Specify the destination and filename for your recording based on your recording
destination. When specifying the path, all folders in the path must already exist.
Monarch LCS will not create new folders.

Important Blank spaces are not supported in the base name. Use underscores
in place of blank spaces. For example, enter Recordingl_Stagel instead of
Recordingl Stagel as the base name for the file.

e USBor SD card When recording to a USB device or SD card, enter the
folder(s) on the recording device to which you want to record, if applicable,
followed by the base name. For example, if you want to name your file
Recording1, and save the file in a folder named Files that is contained within
another folder named Project on the root directory, enter
Project/Files/Recording. If you want to save the file in the media device's
root directory, enter Recordingl.
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* Network Use this option to record your input source to a shared folder on

L

the network. The method for entering the path and filename depends on the
operating system of the computer that contains the shared folder.

Note Formoreinformation on supported operating systems, see “Supported
operating systems” on page 2.

— Windows When recording to a shared folder that is on a Windows

system on the network, you must enter the IP address of the location on
the network to which you want to record, followed by the shared folder
name, and then the base name for the file in the following format:

//IP address/shared folder name/basename

For example, if you want to name your file Recording1, and save the file
to a shared folder named Files that is located on a network computer with
an IP address of 123.456.7.890, enter //123.456.7.890/Files/Recording|.

Important If the network destination has a firewall, it must be disabled
in order to record to the network location.

Mac OS X El Capitan When recording to a shared folder that is on a
Mac OS X El Capitan system on the network, the folder to which you
want to save the file must be shared using the Network File System (NFS)
file-sharing protocol (see Appendix B, “Sharing a Mac OS X folder using
NEFS protocol”).

Important Shared folders that use a file-sharing protocol other than
NFS are not supported with Monarch LCS for recording.

When entering the path and filename, you must enter the IP address of the
location on the network to which you want to record, followed by the full
path to the shared folder from the root directory, and then the base name
for the file in the following format:

//IP address:/full path to shared folder/basename

For example, if you want to name your file Recording! and save the file to
a shared folder named Files that is located on the Desktop under Matrox

in the Users root directory folder on a network computer with an IP
address of 123.456.7.890, enter the following:

//123.456.7.890:/Users/Matrox/Desktop/Files/Recording 1

Tip You can obtain the full path to the shared folder by right-clicking
the folder, and then clicking Get Info.

Domain, Username, and Password

When recording your source input to a network location (see “Media” on

page 48) and Monarch LCS is not on the same domain as the network, enter the
network domain. If required, also enter the Username and Password that is
used to access the network.
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Open Capture XML information
See “Open Capture option” on page 40.

Settings page (Save/Load tab)

The Monarch LCS lets you save up to eight profiles that you can load at any time.
The profiles contain all the settings you selected in the Production and Encoder
tabs. To access the Save/Load tab, open the Monarch LCS Command Center
(see “Accessing the Command Center” on page 24), click Settings, and then
click Save/Load.

CommaNs caTe Matrox Monarch"LCS

[_smer__J

evice

The Save/Load tab opens with the current settings (set in the Production and
Encoder tabs) displayed. You can save the current settings to a new profile, or
save over a previously saved profile. The following sections explain how.

@ Important Please note the following:
» If you leave the Save/Load page before clicking Apply, all changes will be
lost.

* Do not connect or disconnect any cables to the Monarch LCS while settings
are being applied.

Profiles

Monarch LCS lets you save up to eight profiles that you can load at any time.
Profiles are made up of the encoding parameters and production settings,
including operating mode and destination (see “Status page” on page 28).

Settings page (Save/Load tab)
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Whether you use preset or custom parameters, you only need to enter them once,
and then save them as a unique profile.

Saving a profile
1 Go to the Production tab of the Settings page and select the Operating
Mode.

2 Enter your desired settings in that mode and click Apply.

3 Go to the Encoder and/or Production tab, enter your desired settings (for
both channels) and click Apply.

4 Go to the Save/Load tab and click Save. A window opens to save the
settings as a new profile (select an empty profile) or to save over a previously
saved profile (overwrite).

COMMAND CENTER [Matrox' Monarch”LCS]|

- — T
Production  Encoder
e
Profile Name None Profile Name Lecture 1
OPERATING MODE Operating Mode: Dual Isolated Operating Mode: Side-by-Side
Video Inputs Selected: HDMI A HDMI B Video Inputs Selected: HDMI A, HOMI B
o [ Audio Input Selected:  Digital A, 48 kiHz [Audio Input Selected:  Digital A, 48 kHz
SDI Output Selected:  Input A [SO1 Output Selected:  Input A
HOMI Output Selected: Channel preview HDMI Output Selected: Channel preview
Channel 1 |Channel 1
Delivery mode: RTSP Delivery mode: RTSP
[Video Encoder Settings: 1280x720p, 30/25 fps, 4500 kby/s; Video Encoder Settings: 1280x720p, 30/25 fps, 4500 kb/s;
Profile: MAIN Profile: MAIN
Settings Frame Slices: 1 Frame Slices: 1
Deblocking Filter: False. Deblocking Filter: False
e | Audio Encoder Settings: 256 kb/s [Audio Encoder Settings: 256 kb/s
Destination: rtsp://192.168 Stream1 Destination: rtspi//192.168 Stream1
Channel 2 |Channel 2
Delivery mode: Record Delivery mode: Record
[Video Encoder Settings: 1280x720p, 30/25 fps, 5500 kby/s: Video Encoder Settings: 1280x720p, 30/25 fps, 5500 kb/s;
Profile: BASELINE Profile: BASELINE
Frame Slices: 1 Frame Slices: 1
Deblocking Filter: False. Deblocking Filter: False
| Audio Encoder Settings: 256 kb/s [Audio Encoder Settings: 256 kb/s

Note You can also rename a profile from the Profiles list using this method.

Loading a profile
1 Go to the Save and Load tab of the Settings page and select a profile from
the Profiles list and click View.

2 Click Load when the Replacement Settings window listing the profile
settings opens to accept.

The Current Settings window will be updated with the profile settings while the
Production and Encoder tabs are uploaded with the new settings. The profile
configuration is now active. Apply is not required.
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Device page

The Device page is where you access various settings related to all aspects of the

Monarch LCS and its operation. You access these settings by clicking the tabs at
the top of the Device page.

@ Important Please note the following:

» If you leave a tab of the Device page before clicking Apply (when
applicable), all changes will be lost.

* Do not connect or disconnect any cables to the Monarch LCS while settings
are being applied.

Account tab

The Account tab in the Command Center is where you give a descriptive name
to your Monarch LCS device and change your Monarch LCS password.To access
the Account tab, open the Monarch LCS Command Center, and then choose
Device > Account.

COMMAND CENTER Matrox’ Monarch”LCS)|

Automatic Configuration IP Setup Date and Time File Transfer Scheduler About

Devicename:  [MonarchLCSL o ](Change )

Device nhame and password

By default, the device name is set to Monarch LCS. You can give a unique name
to each Monarch LCS device for easy identification within the Command Center
and the Matrox Monarch LCS Utils (see “Monarch LCS Utils application” on
page 18). This is especially useful when you have multiple Monarch LCS devices
on the same network. To change the name of your Monarch LCS, type the desired
name in the Device name box, and then click Change.
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By default, the Monarch LCS username and password are set to admin. The
device username cannot be changed, however, we do suggest that you change the
device password. To change the Monarch LCS password, enter the current and
new passwords, and then click Change. For information on resetting the
password to factory default, see “Reset to factory defaults” on page 14.

Automatic Configuration

The Automatic Configuration tab in the Command Center is where you can
export the current Monarch LCS settings to an XML file (called the Monarch
LCS configuration file), import settings from a previously-created configuration
file, or import settings from the same XML file hosted on a web page.

When you have a Monarch LCS configuration file, you can copy it to a USB
device, connect the device to USB port 2, and then perform a factory reset to
automatically load the settings. For more information on performing a factory
reset, see “Network connection and IP address” on page 18.

The option to boot up Monarch LCS with all settings loading automatically from
a USB device, or loading settings from a web page at device reboot, allows you to
deploy other Monarch devices without logging in to the Command Center.

Accessing the Automatic Configuration tab

To access the Automatic Configuration tab, open the Monarch LCS Command
Center (see “Accessing the Command Center” on page 22), and then choose
Device > Automatic Configuration.

COMMAND CENTER Matrox Monarch’LCS|

CHANNEL STATUS

CH1  |[ieH2 | 1P Setup Date and Time File Transfer Scheduler About

START
STOP 3
Load Configuration
«««««
From Web Page
Load settings from a web page:
= ] & Load settings at device reboot
Save Configuration
Export current settings to a Monarch LCS configuration file:
Generate file
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Loading settings from a Monarch LCS configuration file
You can import settings from a previously-generated Monarch LCS configuration
file. The file must be located on your computer or somewhere that is accessible
from your computer (see “Generating a configuration file” on page 57).

1 Go to the Automatic Configuration tab of the Command Center.

2 Under Load settings from a Monarch LCS configuration file, click
Browse.

3 Select the file you want to load.
4 Click Load.

Your Monarch LCS settings will now match those of the chosen configuration
file.

Loading settings from a web page

You can import Monarch settings from a specific web page that is hosting the
configuration file generated in the Command Center (see “Generating a
configuration file” on page 57). This option is particularly useful when there is a
need to oversee the Monarch LCS operation from a central control environment.
You can set bit rates and destinations by managing a web page instead of logging
into the Monarch LCS Command Center.

1 Go to the Automatic Configuration tab of the Command Center.

2 In the Load settings from a web page field, type the URL address of a
page hosting the configuration parameters.

3 Click Load.
4 (Optional) Select Load settings at device reboot if you want to have your

Monarch LCS automatically load the settings from the specified URL the
next time it boots up.

Your settings will now match those of the chosen configuration file.

Note With Load settings at device reboot selected, you only need to
reboot/reset your Monarch LCS and it checks the specified URL for updated
settings.

Generating a configuration file

You can export your current settings as a Monarch LCS configuration file, which
you can then save to your computer, to a USB device connected to your
computer, or to a network drive. You can then use the configuration file to
configure other Monarch LCS devices.

Note You cannot save to a USB device connected to the Monarch LCS.
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1 Go to the Automatic Configuration tab of the Command Center.

2 Under Export current settings to a Monarch LCS configuration file,
click Generate file.

3 Select a save location. Do not change the filename
(MonarchLCSSettings.xml) if you plan to automatically configure a Monarch
from a USB device (see “Automatically importing Monarch settings on
factory reset”).

The Monarch LCS configuration file is created, and contains all the Monarch
settings as XML parameters.

Automatically importing Monarch settings on factory
reset

On factory reset, the Monarch LCS can automatically import configuration
settings from a Monarch LCS configuration file that is on a USB device
connected to the USB port 2.

1 Copy the Monarch LCS configuration file to a USB device (see “Generating
a configuration file”).

Note The configuration file must have the original filename, given by the
Monarch LCS when the file was generated (MonarchLCSSettings.xml).

2 Connect the USB device to the Monarch LCS' USB port 2 (see “USB ports 1
and 2” on page 7).

3 Perform a factory reset by pressing and holding the Reset button on the
device for at least five seconds (see “Reset to factory defaults” on page 13).

The Monarch LCS boots up with your settings loaded.

For more information on Monarch configuration files, including generating or
editing configuration files, consult the Matrox Monarch LCS Dev Tools Reference
Guide, which is provided in PDF format in the Matrox Monarch LCS Support
section of our website at www.matrox.com/video/support.

IP Setup tab

The IP Setup tab in the Command Center lets you switch the Monarch LCS IP
mode between DHCP and Static. By default, Monarch LCS is set to DHCP
mode.

Important Changing the IP mode will end the current Command Center
session. To access the Monarch LCS Command Center again via IP address, you
will need to enter a different Monarch LCS IP address in your browser’s address
field. If switching to Static mode, you may also be required to change your
computer’s network configuration. For information on obtaining the Monarch
LCS IP address and accessing the Command Center in DHCP or Static mode, see
Chapter 3, “Network Connection and Setup”.
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To access the IP Setup tab, open the Monarch LCS Command Center, and then
choose Device > IP Setup.

COMMAND CENTER

CHANNEL STATUS

CH1 | eH2 | Account Automatic Configuration

START
STOP @DHCP
O static

1P address: [192
SO Subnet mask [255 2552550
|

DNS server. ‘ ‘

I: OPERATING MODE :l
UATED) I Display this Monarch LCS on the network as a UPnP device

Gateway:

Status

Settings

Device

Setting the IP mode to DHCP
Set Monarch LCS to DHCP IP mode when connecting to a network with a DHCP
server, such as through a router.

1 Select DHCP.
2 Click Apply.

Tip See “Network connection and IP address” on page 18 for instructions on
how to connect Monarch LCS to a network with a DHCP server, and how to
acquire the Monarch LCS network IP address to access the Command Center.

Setting the IP mode to Static
Set Monarch LCS to Static IP mode when connecting to a network without a
DHCP server.

1 Select Static.

2 Enter a static IP address for your Monarch LCS. Unless you change this
address, the default static IP address will be used (169.254.1.11). If you reset
the device in Static IP mode (see “Switch to Static IP mode” on page 13), the
static IP address reverts to default.

Note When connecting multiple Monarch LCS devices on the same
network, each Monarch LCS device must have a unique network IP address.

3 Enter the Subnet mask on your network to which Monarch LCS is
connected. By default, the subnet mask is set to 255.255.255.0.
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4 Enter the Gateway IP address and DNS server.
5 Click Apply.

& Tip See Chapter 3, “Network Connection and Setup” for instructions on how to
connect Monarch LCS to a network without a DHCP server, how to change your
computer’s network configuration to establish a connection between your
computer and the Monarch LCS device, and how to access the Command Center.

Preventing Monarch LCS from appearing as a UPnP
device on the network

The Monarch LCS uses the Simple Service Discovery Protocol (SSDP) to
broadcast itself as a Universal Plug and Play (UPnP) device. This means that it
will appear in Windows Explorer (not visible in Mac OS) as if it were a printer,
external hard drive, or similar UPnP device.

This feature is enabled by default, and makes it easier to find the Monarch LCS
on a network if you do not know the device IP address. However, for security
reasons you may not want the Monarch LCS to appear on your network for
anyone to see. If so, you can disable SSDP to prevent the Monarch LCS from
appearing as a UPnP device.

—> To prevent the Monarch LCS from appearing:

1 Access the Monarch LCS Command Center (see “Accessing the Command
Center” on page 22).

2 Choose Device > IP Setup.
3 Clear Display this Monarch LCS on the network as a UPnP device.
4 Click Apply.

The Monarch LCS will no longer be visible in Windows Explorer as a UPnP
device. You may need to restart Windows Explorer for Monarch LCS to no
longer appear on the network.

Note By using this option, this Monarch device will not automatically appear
on the Monarch LCS Utils list of connected devices. You must use the Find All
button for the Monarch LCS to appear.

Date and Time tab

The Date and Time tab in the Command Center lets you set the date and time
for your Monarch LCS device. The date and time are used in the naming of the
recorded files (see “Path and filename” on page 51).

@ Important To save changes made in the Date and Time tab, you must click
the Apply button. A Monarch LCS hardware reboot is required to apply the
changes. If you leave the Date and Time tab before clicking Apply, all changes
will be lost.
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To access the Date and Time tab, open the Monarch LCS Command Center, and
then choose Device > Date and Time.

COMMAND CENTER

CHANNEL STATUS

CH1 |[eHz2 | Account

Automatic Configuration

IP Setup Date and Time

START
STOP ® Manual

O Automatic

NTP server: |lime.nrc.ca

ST T—

Time zone: [{GMT-5.00) Eastern Time (US & Canada) V|

I: OPERATING MODE :|
DU

Current date and time: 28/11/2016, 16:36:50

Setting the device date and time

You can set the date and time manually or automatically by using an NTP server..

Manually

Automatically*

1 Select Manual.

2 Set the Time, and enter a Date in
the format DD/ MM/YYYY, or

click [ to select a date from the
calendar.

3 Click Apply. You’ll be notified
that Monarch LCS will be
rebooted in order to apply the
changes.

Select Automatic.

Enter a local or public NTP server
address. The default NTP server
address is time.nrc.ca.

Select a Time zone from the list.
The current date and time
associated with the selected NTP
server and time zone are displayed
next to Current date and time.
Click Apply. You’ll be notified
that Monarch LCS will be
rebooted in order to apply the
changes.

*Setting the date and time automatically requires a local or public NTP server address. An
Internet connection is required to use a public NTP server.

Device page
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File Transfer tab
The File Transfer tab in the Command Center lets you transfer files from a local
storage device (USB/SD card) to a network folder.

To access the File Transfer tab, open the Monarch LCS Command Center, and
then choose Device > File Transfer.

COMMAND CENTER \'I\/Iat

CHANNEL STATUS

CH1 | GH2 | Account Automatic Configuration IP Setup Date and Time File Transfer

START

File source: [USB1 %

Network destination:

Domain:

. ]
Username: :l
[}

Password:

— Transfer all:
DUALISO
Automatic file transfer:
Start time: he[0 Jmin
hr[D|mi

Stop time:

File transferring

With this feature, you can manually start a file transfer, or transfer files
automatically during a set transfer window of the day. The Monarch LCS keeps
track of which files on the storage device were transferred, and will only transfer
files that have not previously been transferred.

To manually start a transfer, click the Transfer button. To perform a transfer at an
specified time, select Automatic file transfer and then set a time (see
“Automatic file transfer” on page 63 for more information).

During the transfer, the File transferring... indicator will display in the
Command Center side menu and the encoder LED will blink, changing from red
to blue.

Note The Status page displays a message when a file did not successfully
transfer.

A metadata (XML) file is created on the storage device when a recording is made
on the Monarch LCS. There is one XML file per recording. This XML file is only
located on the storage device, and contains a tag identifying whether or not the
file was transferred.

Chapter 4, Using the Command Center
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@ Important Note the following:

* The transfer destination has to be a valid network path (a defined network
location).

* A file transfer cannot start if the Monarch is already recording or streaming
without stopping the streaming/recording session.

 If a file transfer is running and you begin a recording/streaming session, the
file transfer will stop.

* If the file already exists in the destination network folder, it will not be
overwritten or transferred again.

* Itis recommended that you use a blank storage device (USB or SD card)
when recording a file to be transferred.

* Any file(s) interrupted during a transfer will retain its untransferred status on
the storage device, and then be transferred the next time a manual or
automatic transfer occurs.

* Open Capture XML metadata files are also transferred when using the File
Transfer feature; however, the Monarch will only transfer the files found on
the selected media (even if a video referenced in the Open Capture XML file
is located on another USB/SD card). For more information, see “Open
Capture option” on page 40.

Transfer all

Checking the Transfer all box before you manually or automatically start a
transfer (see “Automatic file transfer”), transfers all video files (.mov and .mp4)
on the storage device even if they have already been transferred, overriding any
XML files (see“File Transfer tab” on page 62 for more information).

Note Previously transferred files will not be transferred if the destination
folder already contains those same files.

Automatic file transfer

The Automatic file transfer option allows you to set a time range during which
the Monarch LCS will attempt to transfer all untransferred files to your
previously specified network destination (see“File Transfer tab” on page 62 for
more information). When the allotted time window ends, any remaining files (to
be transferred) will transfer during the next window or manually.

Note If the Transfer all option is selected when an automatic transfer occurs,
all MOV and MP4 files will also be transferred, unless the destination folder
already contains those files.

To set up an automatic file transfer:

Device page
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1 Check the box to set a start and stop time.
2 Enter the Start and Stop times (0:00 to 23:59).
3 Click Apply.

The Monarch LCS will transfer video files until all files have been sent or until
the end of the allotted time (transfer window).

Note Leaving the Automatic file transfer box selected will have the
Monarch LCS attempt to transfer any untransferred files at the same time every
24 hours, until you clear the selection. Previously transferred files will not
transfer a second time or be overwritten.

Scheduler tab

The Scheduler tab in the Command Center lets you schedule a streaming or
recording session for a future date. The sessions are displayed as events on a
calendar.

To access the Scheduler tab, open the Monarch LCS Command Center, and then
choose Device > Scheduler.

COMMAND CENTER Matrox’ Monarch”LCS)|

HANNEL STATUS

CH1 | eH2 | Account Automatic Configuration IP Setup Date and Time File Transfer Scheduler About

@ sheding e ]

Scheduler Span: [ 2016-11-29 - 2017-01-29]

< | > || today DECEMBER 2016 list | month | week | day

Sun Mon Tue Wed Thu Fri Sat
2 2 3

1
[11a Ciass 201 [11a Cass 201

uuuuu

Scheduler mode

You can operate the Monarch LCS from a schedule or manually. Using the
Monarch LCS in Scheduler mode allows you to automatically start and stop a
streaming or recording session. When the Monarch LCS is in Scheduler mode,
the Scheduler icon appears in the Command Center side menu.

When the Monarch LCS is in Scheduler mode, you will not be able to manually
start a session; however, you will be able to manually stop a session.

Note If not already switched off, Scheduler mode will be turned off when you
load a calendar. Remember to switch it on afterwards. For more information
about calendars, see “Making a calendar”.
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Events

Events are upcoming streaming or recording sessions, within the Scheduler
calendar. An event represents the start and stop time of a session. Events must be
created using a specific set of parameters. Using either Microsoft Outlook or
Google Calendar, make sure that:

* The event summary/name begins with “LCS-" (with a space after the dash).

¢ The location is the name of the Monarch LCS unit to be used for that
particular event.

e A valid start time and end time is entered for each event.
Note Please note the following:
* The minimum scheduled recording length is one (1) minute (there is no
maximum length). You cannot set all-day events.

* Make sure to enter all the details correctly. If you need to make any changes
to an event (e.g. Start time change, remove an event, etc.), you will have to
do so in the original calendar, then load a new .ics file to replace the first one
containing that event.

* You can only schedule calendar events occurring within the coming two (2)
months.

* The Scheduler will not use a time zone that might have been set as part of an
individual event.

Events on the Scheduler calendar are color-coded to inform you of their state:

Event Color Event Status
Blue Scheduled
Green Successful
Red Failed
Yellow Stopped by the user
Gray Discarded (overlap)

For more information on events, see “Scheduler mode”.

Making a calendar

The Monarch LCS uses iCalendar (.ics) files to schedule events (streaming or
recording sessions). iCalendar is a global format for (plain text) calendar files
used by calendar and email programs like Google Calendar and Microsoft
Outlook (recommended). These files enable the sharing and publishing of
information from one calendar to another. The main information stored in .ics
files is the title, start time, end time, and a brief summary of the calendar event(s).

Device page
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To create a calendar to be used with the Monarch LCS:
1 Use either Google Calendar or Microsoft Outlook to create scheduled
streaming or recording events.

For specific instructions on how to create iCalendar files in either Google
Calendar or Microsoft Outlook, please refer to the help provided by Google
and Microsoft in their respective applications.

Begin each event name with “LCS-".
Enter a start time and end time for each event.

Enter the name of the Monarch LCS unit as the Location for each event.

a1 A W N

Export the iCalendar file to a location that can be accessed by the Monarch
LCS Command Center.

6 From the Scheduler tab in the Command Center, click Browse to find the
file you created, then click Load.

The Status page will display the name of the loaded .ics file and whether the
feature is on or off. For more information about events, see “Events”.

Note Even though your calendar may contain events spanning several months,
the Monarch LCS will only process events scheduled within the coming two (2)
months. This two-month span is displayed at the top of the Scheduler tab. You
may reload the calendar whenever needed.

About tab

The About tab in the Command Center lets you see the serial number and current
firmware version of your Monarch LCS device, provides a link to the latest
Monarch LCS documentation (an Internet connection is required), and displays
the Matrox Limited Warranty for Monarch LCS.

Note To update the Monarch LCS firmware, see “Updating the Monarch LCS

firmware” on page 23.
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To access the About tab, open the Monarch LCS Command Center, and then
choose Device > About.

COMMAND CENTER Matrox Monarch”"LCS|

CH1 [L€H2 | Account Automatic Configuration IP Setup Date and Time File Transfer Scheduler

START Device firmware version:

Serial Number:

b Documentation:  Click here for the Matrox Monarch LCS documentation.

Hardware warranty:  Click here for the Matrox Monarch LCS warranty.
o) ) Third-party licenses:  Click here for the list of open source content and licenses.

trox Software Lieense Agreement

MATROX SOFTWARE LICENSE AGREEMENT (HEREAFTER REFERRED TO AS LICENSE)
OPERATING MODE A

A THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD (MATROX') CONCERNING THE USAGE OF THE MATROX SOFTWARE. Y DOWNLOADING,
INSTALLING, COPYING, ACCESSING, CLICKING ON AN "ACCEPT" BUTTON, OR OTHERWISE USING THE SOFTWARE, THE LICENSEE AGREES TOTT
At

DuAEIEO) £ TERMS ON BEHALF OF YOUR K‘/DMPANV‘ ORGANIZATION, EDUCATIONAL INSTITUTION, QR AGENGY, INSTRUMENTALITY, OR DEPARTMENT OF THE FEDERAL
E: o

AGREE TO THE TERMS OF THIS LICENSE, PLEASE | ?ETLIRN 'YOUR MATROX PRODUCT. IF THE SOFTWARE WAS DOWNLOADED, DESTROY ALL COPIES OF THE SOFTWARE.

In this License “Software" refers o: any firmware, software, associated software components, media, printed materisls, and "criine! or slestronic dosumentation refated fo Matrox produs.

ST derivatives. the use of any Software. limitations:
e

Ifyou are an end user, the "End User License" shall apply to you.
Ifyou are an original equipment manufacturer (OEM), the "GEM License" shall apply to you.

END USER LICENSE

Copyright © 2016 Matrox Electronic Systems Ltd. All rights reserved.

o
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Recording file size and duration

This appendix contains tables
of approximated recording file
sizes and recording lengths.
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Recording file sizes and duration

The following tables list the approximate recording file size based on the average
video data rate and recording duration, and the approximate maximum recording
duration given the average video data rate and available disk space.

Note Unless a specific recording duration limit was set in the record settings,
your Monarch device limits the duration of each recording to 4 hours and 50
minutes. The recording will automatically stop when the duration limit is
reached.

Approximate file size

Recording Average Video Data Rate (kb/s)
Duration 500 2000 5000 15 000
5 min 18.8 MB 75 MB 188 MB 563 MB
30 min 1125 MB | 450 MB 1.1 GB 3.4 GB
60 min 225 MB 900 MB 23GB 6.8 GB
3 hrs 675 MB 2.7 GB 6.8 GB 20.3 GB
4hrs 50 min | 1.1 GB 4.5 GB 11.3GB 33.8 GB

Approximate maximum recording duration

Average Video Data Rate (kb/s)

Disk Space

500 2000 5000 15 000

4 GB 17.8 hrs 4.4 hrs 107 min 36 min

16 GB 71.1 hrs 17.8 hrs 7.1 hrs 2.4 hrs
32 GB 142.2 hrs 35.6 hrs 14.2 hrs 4.7 hrs
64 GB 284.4 hrs 71.1 hrs 28.4 hrs 9.5 hrs
256 GB 1138 hrs | 284.4 hrs 114 hrs 38 hrs

1TB 4444 4 hrs | 1111.1 hrs | 4444 hrs | 148.1 hrs

Appendix A, Recording file size and duration
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instructions for sharing Mac OS
X El Capitan folders using NFS
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Introduction

To record to a shared folder that is on a Mac OS X El Capitan system on the
network (see “Destination settings (record)” on page 48), the folder must be
shared using the Network File System (NFS) file-sharing protocol as explained
below.

Note To share a folder using the NFS protocol, the full path to the folder that
you want to share is required. You can obtain the full path to the folder by
right-clicking the folder, and then clicking Get Info.

Folder sharing with a Mac OS X El Capitan

system

1 On the computer that contains the folder that you want to share, make sure

that you're logged in as an administrator and that your user account has a
password. User accounts that do not have a password cannot be used to share
a file using the NFS protocol.

2 In the Finder menu, choose File > New Finder Window.
3 In the Applications folder, click the Utilities folder, and then click

Terminal.

In the Terminal window, type the following command, where “Path” is the
full path to the folder that you want to share:

echo /Path -mapall=$(logname)| sudo tee -a /etc/exports

For example, to share a folder named Files that is located on the Desktop
under Matrox in the Users root directory folder, type the following
command:

echo /Users/Matrox/Desktop/Files -mapall=$(logname)| sudo tee -a
/etc/exports

For added security, you can restrict write access to the folder to one device
by adding the IP address of the Monarch device that you want to use to write
to the folder. For example, if the IP address of the Monarch device is
169.254.1.11, type the following command:

echo /Users/Matrox/Desktop/Files 169.254.1.11 -mapall=$(logname)| sudo
tee -a /etc/exports

5 Press ENTER.
6 Type your user account password, and then press ENTER.

7 Type the following command:

sudo nfsd restart

8 Press ENTER.

9 Close the Terminal window.

Appendix B, Sharing a Mac OS X folder using NFS protocol
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General

Regulatory compliance

— EMC: FCC Class A, CE Mark Class A, ACMA C-Tick Mark
— RoHS Directive 2011/65/EU

Weight

— 0.6 kg

Power

— Input: 9-24 VDC

— Connector: DIN4

— Total power consumption: 20-30 Watts (42 max)
Power Supply

Line voltage: 100-240 VAC

Frequency: 50-60 Hz

Input connector: IEC320-C8

Output connector: DIN4 Locking power

Output: 12VDC (42 W)

International Adapter

— US/UK

— European

Connections

HDMI inputs (2)

Supported video input formats (auto-detected):
« 1920 x 1080p at 25/29.97/30/50/59.94/60 fps
« 1920 x10801 at 25/29.97 fps

« 1280 x 720p at 50/59.94/60 fps

HDMI YCbCr 4:2:2 / RGB

HDMI embedded audio, 2-channel

HDCP not supported

Standard Type A HDMI connector (19 pins)

Appendix C, Matrox Monarch LCS Specifications
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HDMI output
+ HDMI YCbCr 4:2:2 / RGB
« HDMI embedded audio, 2-channel
+ Standard Type A HDMI connector (19 pins)
SDI input
— Supported video input formats (auto-detected):
« 1920 x 1080p at 25/29.97/30/50/59.94/60 fps
« 1920 x1080i at 25/29.97 fps
« 1280 x 720p at 50/59.94/60 fps
« 720 x 576i at 25 fps
« 720 x 486i at 29.97 fps
— 8-channel, 24-bit SDI embedded audio, 48 kHz sample rate, synchronous
— SDI compliant with SMPTE 259M/292M/424M(Level A)/425M
— BNC connector (75 Q), terminated
— Full audio and VANC preservation
SDI output
— SDI compliant with SMPTE 259M/292M/424M(Level A)/425M
— 8-channel, 24-bit SDI embedded audio, 48 kHz sample rate, synchronous
— BNC connector (75 Q)
Unbalanced analog audio input
— 1x stereo pair
— 3.5 mm (1/8”) stereo jack
— Input impedance: Hi-Z
Unbalanced analog audio output
— 1x stereo pair
3.5 mm (1/8”) stereo jack
Output impedance: 25 Q
THD+N at 1 kHz, 10 k€, nominal level: < 0.05%
— Frequency response: 20 Hz to 20 kHz +/- 1 dB

Channel separation, nominal level: -85 dB

Signal-to-noise ratio: -88 dB

Data ports

— 2x 2.0 USB ports

— 1 x auto-sensing 10/100/1000 Base-T Ethernet J-45 port
— 1 x SD/SDHC card slot.

General
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Environmental specifications

Minimum/maximum room operating temperature: 0 to 40° C
Minimum/maximum storage temperature: —20 to 60° C

Maximum altitude for operation: 3,000 meters

Maximum altitude for transport: 12,000 meters

Operating humidity: 20 to 80% relative humidity (non-condensing)
Storage humidity: 5 to 95% relative humidity (non-condensing)

Dimensions
The dimensions for the Monarch LCS are as follows.
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This appendix explains how
you can register your Matrox
product and obtain customer
support.
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How to get Matrox customer support

If you have a problem that you’re unable to solve by referring to the
documentation for your Matrox product, please contact your Matrox
representative. He or she should be able to help you quickly correct any
installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further
information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our
website at www.matrox.com/video/support.

Only registered users are entitled to customer support, utilities, special
promotional offers, and access to our user forum.

Keep up to date with our website

In addition to registering your Matrox product, our website offers you
up-to-the-minute information about Matrox products and software updates. Be
sure to place our site in your favorites or bookmarks:
www.matrox.com/video/support.

Contacting us

Matrox is proud to offer worldwide customer support. Please use the contact
information for your Matrox product and area as provided on our website at
www.matrox.com/video/support.

Appendix D, Matrox Customer Support
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Compliance Statements
USA

FCC Compliance Statement

Remark for the Matrox hardware products supported by this guide

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

WARNING
Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The
use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

Canada

(English) Industry Canada Compliance Statement

CAN ICES-3 (A)/NMB-3 (A)

Remark for the Matrox hardware products supported by this guide

These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

(Francais) Conformité avec les exigences de I'Industrie Canada

CAN ICES-3 (A)/NMB-3 (A)

Remarque sur les produits matériels Matrox couverts par ce guide

Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Reglement sur
le brouillage radioélectrique édicté par Industrie Canada.

Europe

(English) European user’s information — Declaration of Conformity

Remark for the Matrox hardware products supported by this guide

These devices comply with EC Directive 2014/30/EU for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and
EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet
EC requirements, shielded cables must be used to connect the equipment and other peripherals. Analog A/V cables connected to Matrox MXO2 Mini must be limited to
less than three meters to comply with EEC and EMC directives. These products have been tested in a typical Class A compliant host system. It is assumed that these
products will also achieve compliance in any Class A compliant system.

(Francais) Informations aux utilisateurs Européens — Déclaration de conformité

Remarque sur les produits matériels Matrox couverts par ce guide

Ces unités sont conformes 2 la directive communautaire 2014/30/EU pour les unités numériques de classe A. Les tests effectués ont prouvé qu’elles sont conformes aux
normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces produits dans un environnement résidentiel peut causer des interférences radio, dans ce cas
I’utilisateur peut étre amené a prendre les mesures appropriées. Pour respecter les impératifs communautaires, les cables de connexion entre 1’équipement et ses
périphériques doivent étre blindés. Afin de se conformer aux exigences des directives de la CEE et de 'EMC, les cables analogiques audio/vidéo reliés a Matrox MXO02
Mini ne doivent pas dépasser trois metres. Ces produits ont été testés dans un systeme hote typique compatible classe A. On suppose qu’ils présenteront la méme
compatibilité dans tout systéme compatible classe A.

(Deutsch) Information fiir europaische Anwender — Konformititserklarung

Anmerkung fiir die Matrox Hardware-Produktunterstiitzung durch dieses Handbuch

Diese Geriite entsprechen EG Direktive 2014/30/EU fiir ein digitales Geriit Klasse A. Sie wurden getestet und entsprechen demnach EN55022/CISPR22 und
EN55024/CISPR24. In einer Wohnumgebung kénnen diese Produkte Funkinterferenzen erzeugen, und der Benutzer kann genétigt sein, entsprechende Mafnahmen zu
ergreifen. Um EG-Anforderungen zu entsprechen, miissen zum Anschliefen des ausriistung und anderer Peripheriegerite abgeschirmte Kabel verwendet werden.
Analoge A/V Kabel, die an Matrox MXO2 Mini angeschlossen werden, miissen eine Linge von weniger als drei Metern aufweisen um den EWG-und EMV-Richtlinien
zu entsprechen. Diese Produkt wurden in einem typischen, der Klasse A entsprechenden, Host-System getestet. Es wird davon ausgegangen, daf diese Produkte auch in
jedem Klasse A entsprechenden System entsprechend funktionieren.

(Italiano) Informazioni per gli utenti europei — Dichiarazione di conformita

Nota per i prodotti hardware Matrox supportati da questa guida

Questi dispositivi sono conformi alla direttiva CEE 2014/30/EU relativamente ai dispositivi digitali di Classe A. Sono stati provati e sono risultati conformi alle norme
EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare radiointerferenze, nel qual caso all’utente potrebbe venire richiesto
di prendere le misure adeguate. Per soddisfare i requisiti CEE, I’apparecchiatura e le altre periferiche vanno collegati con cavi schermati. I cavi analogici A/V collegati a
Matrox MXO2 Mini devono essere limitati a meno di tre metri per essere conformi alle direttive di contabilita elettromagnetica e del EEC. Questi prodotti sono stati
provati in un tipico sistema host conforme alla Classe A. Inoltre, si da per scontato che questi prodotti acquisiranno la conformita in qualsiasi sistema conforme alla
Classe A.

(Espaiiol) Informaci6n para usuarios europeos — Declaracién de conformidad

Observacién referente a los productos de hardware de Matrox apoyados por este manual

Estos dispositivos cumplen con la directiva de la CE 2014/30/EU para dispositivos digitales de Clase A. Dichos dispositivos han sido sometidos a prueba y se ha
comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos residenciales, estos productos pueden causar interferencias en las
comunicaciones por radio; en tal caso el usuario deberd adoptar las medidas adecuadas. Para satisfacer las disposiciones de la CE, deberdn utilizarse cables apantallados
para conectar el equipo y demds periféricos. Los cables andlogos de A/V conectados con Matrox MXO2 Mini se deben limitar a menos de tres metros para conformidad
con las directivas del EEC y del EMC. Estos productos han sido sometidos a prueba en un tipico sistema anfitrion que responde a los requisitos de la Clase A. Se supone
que estos productos cumplirdan también con las normas en cualquier sistema que responda a los requisitos de la Clase A.



Digital Video Solutions

www.matrox.com/video



	Trademarks
	Matrox Software License Agreement
	Introduction
	Welcome to Matrox Monarch LCS
	Supported input formats
	Supported operating systems
	Supported Web browsers
	Streaming
	Recording
	About this guide
	Style conventions


	Matrox Monarch LCS Hardware and Connections
	Matrox Monarch LCS hardware
	Input select button
	Encode button (ENCD)
	USB ports 1 and 2
	SD card
	LAN
	RS-232
	Video/audio inputs and outputs
	Powering Monarch LCS
	Using the Reset button

	Status LEDs

	Network Connection and Setup
	Introduction
	Monarch LCS Utils application
	Network connection and IP address
	Finding the Monarch LCS current IP address
	Connecting to a network with a DHCP server (DHCP IP mode)
	Connecting to a network without a DHCP server (Static IP mode)

	Accessing the Command Center
	Updating the Monarch LCS firmware

	Using the Command Center
	Introduction
	Using the Command Center side menu
	Status page
	Monarch LCS errors

	Settings page (Production tab)
	About the Operating Modes
	About the Video section
	About the Audio section
	Configuring Single Isolated mode
	Configuring Dual Isolated mode
	Configuring Switcher mode
	Configuring Picture-in-Picture mode
	Configuring Side-by-Side mode

	Settings page (Encoder tab)
	Record mode
	RTMP and RTSP streaming modes
	Presets
	Frame rate
	Target video data rate
	Include audio
	Advanced settings
	Destination settings (streaming)
	Destination settings (record)

	Settings page (Save/Load tab)
	Profiles

	Device page
	Account tab
	Automatic Configuration
	IP Setup tab
	Date and Time tab
	File Transfer tab
	Scheduler tab
	About tab


	Recording file size and duration
	Recording file sizes and duration

	Sharing a Mac OS X folder using NFS protocol
	Introduction
	Folder sharing with a Mac OS X El Capitan system

	Matrox Monarch LCS Specifications
	General
	Connections
	Environmental specifications

	Dimensions
	Top
	Front
	Side


	Matrox Customer Support
	How to get Matrox customer support
	Registration
	Keep up to date with our website
	Contacting us


	Index
	Compliance Statements

